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��Introduction

What is ACD/ChemSketch

ACD/ChemSketch is a chemical drawing software package from Advanced Chemistry Development, Inc. designed to be used alone or integrated with other applications.  ChemSketch is used to draw chemical structures, reactions and schematic diagrams.  It can also be used to design chemistry-related reports and presentations.

ACD/ChemSketch has the following major capabilities:

Structure Mode for drawing chemical structures and calculating their properties.

Draw Mode for text and graphics processing.

Molecular Properties calculations for automatic estimation of:

molecular weight;

percentage composition;

molar refractivity;

molar volume;

parachor;

index of refraction;

surface tension;

density;

dielectric constant; and

polarizability.

ACD/ChemSketch can stand alone as a drawing package or act as the “front end” to other ACD software such as the NMR Predictor engines.

Additional Modules

There are additional ACD software items which are accessible through the ChemSketch interface, as single-click buttons.  These items, which are increasing in number with each upgrade, are available as additional options and should be considered as separate items.  All of them have separate guides.  Please contact us or consult our Web site for more details on pricing and availability.

ChemBasic—the special programming language that enables the user to customize ACD software (can be downloaded from http://www.acdlabs.com).  As of Spring 2000, ChemBasic version 1.3 freeware is available from our Web site.  Please see Chapter 13, “Goodies”, for some examples of how ChemBasic can be used with ChemSketch.

ACD/I-Lab—the Internet-based service that allows you to get instant access to chemical databases and property predictions programs.  An account on the Interactive Lab can be set up from http://www.acdlabs.com/ilab.  As of Spring 2000, a 2-week demo period can be arranged for the I-Lab.  ChemSketch 4.0 and upwards can access the I-Lab automatically, if run on a PC with Internet connection.  Refer to Chapter 4 for more details.

ACD/Tautomers—checks and generates the most reasonable tautomeric forms of organic structures (included in both freeware and commercial versions of ChemSketch);

ACD/Dictionary – looks up the molecular structure for common drug names.  ACD/Dictionary contains over 48,000 systematic and non-systematic names of the most frequently used chemicals and biologicals.  The entries cover more than 200 therapeutic areas, and the inhibitors for more than 500 different enzymes are also available (included in commercial version only).

The following buttons represent functionality that must be purchased in addition to ACD/ChemSketch:

ACD/pKa Calculator—calculates accurate acid-base ionization constants at 25 degrees Celsius and zero ionic strength for a structure as drawn in the ChemSketch window;

ACD/LogP Calculator—calculates octanol-water partition coefficients (logP values) for neutral molecule as drawn in the ChemSketch window;

ACD/Boiling Point and Vaporization—calculates accurate boiling points at any pressure from 0.001 mm Hg to 10 atm, in most cases to (10 degrees or better, for a structure as drawn in the ChemSketch window;

ACD/Solubility—calculates the solubility of the sketched-in structure as a function of pH;

ACD/Sigma—displays the Hammett-type or related parameters for different substituent groups as drawn in the ChemSketch window;

ACD/Name to Structure – generates a molecular structure for almost any chemical name typed in.  ACD/Name to Structure treats most names of general organic compounds and many natural products derivatives according to IUPAC recommendations on Organic, Biochemical and Inorganic Nomenclature.

What’s New in 4.5

If you are new to this software, we recommend that you work through the examples described in the following chapters.  If, however, you have purchased (or are thinking of purchasing) this software as an upgrade, you are likely already familiar with the basic features of ChemSketch.  In this section we list only the newest features.



Reaction Plus � and Reaction Arrows � tools are now available directly in the Structure mode.  You do not have to switch to the Draw mode for drawing these objects.

The new Reaction tab in the Preferences dialog box (Options menu) allows you to choose among various options for Reaction Plus and Reaction Arrows.

Graphical objects (those created in the Draw mode) can now be selected and moved in the Structure mode as well.  This facilitates the drawing of complex reports.  To enable this feature, make sure that the Select Graphics check box is selected in the Structure tab of the Preferences dialog box (Options menu).

Stereo configuration can be controlled when the Clean and Flip tools are applied.  See the bottom part of the Structure tab in the Preferences dialog box (Options menu).

New structure file formats can be imported:  ChemDraw CDX (*.cdx) files and REACCS RXN (*.rxn) files.  The RXN format is also a newly-supported Export format.

A new additional module can be purchased to be integrated into the ChemSketch Window—ACD/Name to Structure (refer to Section 1.2 for more details).

The ACD/I-Lab add-on allows you to access our prediction modules and various chemical databases via Internet.  Just sign up for an account on the Interactive Lab at http://www.acdlabs.com/ilab.  As of Spring 2000, a 2-week demo period can be arranged for the I-Lab.  The I-Lab can be accessed automatically, if run on a PC with Internet connection.  Refer to Chapter 4 for sample usage of the I-Lab via the ChemSketch interface.

About this Guide

To start using ACD/ChemSketch in its full power you don’t have to read a manual, it is so intuitive and simple to use.  That’s why this guide doesn’t provide comprehensive descriptions of all the options available in the program; rather, it just gets you started.  After reviewing these exercises, you will be able to use ACD/ChemSketch yourself, without any further assistance and with maximum speed and efficiency.

You will be able to view nearly every section of this manual in animated form in the LotusCam®-based movies, downloadable from our Web site (www.acdlabs.com).  (These movies are also present on our demo CD as well as the installation CD.)

This User’s Guide is provided in electronic form, readable with a commonly available word processing program.  If you cannot locate an index topic you need, please do a text string-search in the word processing program for the relevant word or phrase, or related words.

The screen-shots shown throughout this tutorial have been taken with a relatively small window size.  The default display is a window that fills the screen.  Click once on the Minimize button � (upper right-hand corner of window display) to get a smaller working area; click on the Maximize button � to return to full-screen display.

The screen-shots have been taken with the next-to-last version of the software.  We have made every effort to match what you will see in ACD/ChemSketch with what the tutorial shows, but there may be slight discrepancies.

This Guide assumes you have basic familiarity with mouse and file manipulation in Microsoft Windows.



�EMBED PBrush���

Win!!!

Your opinion is important for us.�Once you have used this Guide, we would like your feedback.  How can we improve the documentation for this product?  We have a short questionnaire we would like you to complete.  All eligible respondents will be entered in a draw for a prize of ACD/ChemFolder (or equivalent discount toward the purchase of any ACD software).  Please use MS Word 6.0 or higher to open the file “survey.doc” or use Adobe Acrobat Reader to open “survey.pdf” on the documentation CD you have received with this software, or visit the “Feedback” page at our Web site, http://www.acdlabs.com/feedback/guides.html.  The winner of the draw is announced at the end of the given calendar year.��Useful Definitions

In this tutorial the following terms are used to describe various actions:

Point means move the mouse pointer � to an item.

Click or left-click means move the mouse pointer to an item, and press the left mouse button.

Right-click means move the mouse pointer to an item, and press the right mouse button.

Double-click means move the mouse pointer to an item, and quickly press the left mouse button twice.

Drag means press and hold down the left mouse button while you move the mouse.

In Windows the default mouse button side is on the left.  You can change the default side to the right by summoning the Mouse dialog box from the Windows Control Panel.  (This also permits you to change the speed and motion attributes of the mouse.)

Demo Versions

When the demo version is first loaded to run, you will see a message displayed that informs you this is ACD Demonstration software.  You may also see this message displayed from time to time throughout the normal course of using the demo software.

Demo versions of ACD/Labs programs have some command restrictions such as Save, Copy, Cut, Paste and Print features.  If you try to carry out a restricted operation from a demo version, a dialog box will appear which informs you that it is not permitted.

If you would like to know more about a specific restriction in the full version of the program, please contact us.  Nevertheless, most of the exercises and examples in this guide are designed so that you can execute them with the demo version of this ACD/Labs program as well.

Freeware Version

From April 1999 onward, Advanced Chemistry Development has been making ChemSketch 4.0 and up available as freeware, through the “Free Stuff” link at our Web site.  Please be advised that the freeware version:

does not come with ACD/Dictionary;

might not have the latest enhancements for version 4.5 (see Section 1.3, What’s New);

does not include ACD Add-ins for ISIS/Base or ISIS/Draw; and

does not entitle you to technical support.  (However, there is a newsgroup at news://news.acdlabs.com/acd.public.chemsketch where users can post their questions or share tips.)

�The freeware ChemSketch:

does come with ACD/Tautomers and ACD/3D Viewer; 

should be installed to its own separate folder.  This folder can contain other ACD freeware concurrently available, such as ACD/SpecViewer, ACD/CNMR Viewer, ACD/HNMR Viewer, etc. but should not contain any purchased ACD software.

does include a 15-second sequence listing our other products when it is first started up.  Once the Cancel button becomes active, click it to remove this screen.



To remove the 15-second start-up screen, visit the Web Store!

For More Information…

To see the latest in ACD software and services, please visit our Web site at 

http://www.acdlabs.com

Our Web site is being accessed at the rate of tens of thousands of “hits” per day.  There’s a reason for this: much is offered through our Web site.  As of Summer 2000, we offer free ChemSketch 4.5, a free ISIS 3D Add-in, free ChemDraw extensions and a free 2-week demo key for  “Interactive Lab” sessions where you can run test calculations using Java applets without purchasing software.  There are Lotus Cam-based movies which show the operation of many of our software packages (especially ChemSketch) available for download.

We are constantly updating the information on our Web site.  The Web site will tell you at which scientific conferences you can visit the ACD booth.  You can browse the Frequently Asked Questions page or drop in and “chat” on our newsgroup, which can also be reached via our web page.

If you would like to stay informed of the latest developments in chemical software at ACD, please be sure to sign up for e-mail broadcasts at our Web site page:

http://www.acdlabs.com/feedback/mailing.html 

If you would like to partake of the ChemSketch newsgroup, please access:

news://news.acdlabs.com/acd.public.chemsketch

How to Get Hold of Us

We are accessible through our Web site, phone, fax and regular mail, but by far the most popular way to contact us is via electronic mail.  Questions on pricing, sales, availability and general issues should be directed to 

info@acdlabs.com.

Technical and scientific support issues should be addressed to 

support@acdlabs.com.

Please tell us the name of the software purchaser, the version number and release date of the product you are contacting us about.  (This information is available by selecting Help/About.)  If applicable, please tell us the name of the distributor from whom you purchased the software.

�Basics of ACD/ChemSketch

Objectives

This chapter will familiarize you with

how to start the program;

basics of the ChemSketch interface, namely, the Structure and Draw modes.

Starting ACD/ChemSketch

Once ACD/ChemSketch has been installed on your computer, follow these basic steps to start it:

Start Windows.

Double-click on the ACD/ChemSketch icon to start ACD/ChemSketch.�OR choose the ACD/ChemSketch icon from the Start menu in the Windows 95/98 or NT Taskbar�OR double-click on the program file “chemsk.exe” in the ACD folder.

You will see the splash screen appear, followed by the ChemSketch window.

If this is the freeware version, you will see a 15-second list of ACD products scroll by.  Be patient and click Cancel when it becomes active.

Then you will see a Tip of the Day box, which you can close after reading.

Structure and Draw Mode

When ACD/ChemSketch starts up, you will find many menu commands and toolbar buttons appear dimmed (inactive).  They will be made available as soon as you draw a structure.

In the ChemSketch Window, there are two modes, Structure and Draw.  You switch between them using the buttons in the upper left-hand corner:

�

In the Structure Mode you draw structures and reaction schemes while the Draw Mode presents you with the tools for entering text and drawing various graphical objects.

Structure Mode Screen

Below you can see the screen with the Structure Mode enabled.  Please pay attention to the names and position of the toolbars, since we are going to use these terms throughout the whole Guide.

�EMBED Unknown����Title bar shows the name of the program and the name of the currently open file.  The default file name is NONAMExx.SK2, where ‘xx’ is a counter.

Menu bar contains a series of words.  Each word links to a list (‘menu’) of related commands for working in the ChemSketch window in Structure mode.

General toolbar located right below the menu bar includes tools that are present in both Structure and Draw modes and will help you with tasks relevant to both modes such as:  saving, opening files, undoing/redoing operations, copying and pasting, zooming in and out, as well as inserting various templates.

Structure toolbar placed below the General toolbar and only present in the Structure mode.  This contains tools for drawing and manipulating chemical structures, as well as buttons that link you to additional modules (see Section 1.2).

Atoms toolbar displayed vertically to the left of the screen contains buttons representing atoms, as well as tools for changing atom properties (charge, valence, numbering, etc.).

Reference toolbar placed to the right of the window contains the Table of Radicals and various buttons representing ready-made radicals you take from the table.  You can also access ACD/Dictionary from this toolbar.

Workspace is the open area in the middle where structures are drawn.  (Sample shown.)

Color Palette at the bottom of the workspace allows you to quickly color atoms and bonds in the selected chemical structures (by clicking or right-clicking on the colors).

Status bar contains information that may be useful for the current moment: name of the SK2 file you are working on, page number in the SK2 file, number of fragments in the workspace, molecular formula of the selected structure, as well as one of the available chemical properties for the selected structure.  It also contains a button for automatic I-Lab access.

Draw Mode Screen

Below you can see the screen with the Draw Mode enabled.  Please, pay attention to the names and position of the toolbars, since we are going to use these terms throughout the whole guide.

�EMBED Unknown���

Title bar shows the name of the program and the name of the currently open file.  The default file name is NONAMExx.SK2, where ‘xx’ is a counter.

Menu bar contains a series of words.  Each word links to a list (‘menu’) of related commands for working in the ChemSketch window in Draw mode.

General toolbar located right below the menu bar includes tools that are present in both Structure and Draw modes and will help you with tasks general for both modes such as, saving, opening files, undoing/redoing operations, copying and pasting, zooming in and out, as well as inserting various templates.

Editing toolbar placed below the General toolbar and only present in the Draw mode incorporates tools for editing and manipulating drawn graphical objects.

Drawing toolbar displayed vertically to the left of the screen contains buttons for drawing various graphical objects and text.

Workspace is the open area in the middle where graphical objects are drawn and text is typed.  (Sample shown.)

Color Palette at the bottom of the workspace allows you to quickly color selected objects (by clicking or right-clicking on the colors).

Status bar contains information that may be useful for the current moment: name of the file you are working on, status of the document and page number.



�Drawing Simple Structures

Objectives

This chapter considers the basics of structure drawing, which occurs only in Structure Mode.  The object of this chapter is to give you an overview of the chemical drawing features of ChemSketch.  In this chapter you will learn how to:

draw atoms, bonds (single, double, triple; wedge, coordination, undefined) and labels;

flip a drawn molecular structure;

select, rotate and resize drawn structures; 

output the structure to a file, document or printer; and

clear the screen.

Drawing bonds and atoms is the basic activity in the ChemSketch workspace.  Make sure that you are in Structure Mode for all following actions:

�

Drawing Atoms, Bonds and Labels

Using the Draw Normal Tool

The Draw Normal tool is the default tool when the program is started.  In this mode you can easily draw normal or branched chains and replace the drawn atoms with other atoms from the Periodic Table of Elements.

Make sure that the Draw Normal tool � is enabled on the Structure toolbar and that the Carbon atom � is selected on the Atoms toolbar.

Click in an empty space to draw CH4

Click on CH4 to add a -CH3 group, creating CH3-CH3 with a standard bond length.  Click twice more on the same Carbon to draw �EMBED Unknown���

Click the Set Bond Vertically button � on the Structure toolbar and click on any bond of the structure to rotate it to this orientation: �EMBED Unknown���

Click the Draw Normal button � on the Structure toolbar.

Click on the right-most Carbon atom to draw  �EMBED Unknown���

Repeat the above step to draw the following structures:�	�EMBED Unknown��� , �EMBED Unknown��� , �EMBED Unknown��� and�EMBED Unknown���

Double and Triple Bonds

On the last structure drawn, click once on the last bond to place a double bond there:

�EMBED ACD.ChemSketch.20���

Click there again to place a triple bond:

�EMBED ACD.ChemSketch.20���

Click on the triple bond to make it a single bond again.

If you place a multiple bond that violates the common valence of an atom, a pink X appears to show the error (see below).  To correct your error, click on the bond once or twice to change it back to a single or double bond:�				�EMBED PBrush���

Deleting Atoms Individually

If you have added too many atoms, you can remove them one at a time.

Click the Delete button �.

Click on a few atoms in your practice molecules to practice deleting.

The Undo Command

Another important operation is how to “rescue” yourself from a change that, in retrospect, you wish you had not made.

Click the Undo button �.  This will reset the ChemSketch screen to exactly what it was before your last change. 

As soon as the Undo button is clicked, the Redo button (beside it) also becomes active.

Click the Undo button several more times until you return to the following structure:

�EMBED ACD.ChemSketch.20���

The Undo command can be repeated up to 50 times.  When you begin to draw more complex molecules or graphical objects, we recommend that you develop a habit of saving your work to a file after making several changes.

�Changing the Atom

Click the Periodic Table button � on the Atoms toolbar to open the Periodic Table of Elements:

�

Click the Fluorine button in the Periodic Table of Elements.  Note that the Fluorine button � is added to the Atoms toolbar.

Click on the left-most Carbon to replace it with a Fluorine atom: �EMBED Unknown��� 

When you select new elements from the Periodic Table of Elements, the corresponding buttons are automatically added to the Atoms toolbar.  To remove these buttons from the Atoms toolbar, double-click on any of them or double-click on the Atoms toolbar and choose Yes.

Using the Draw Continuous Tool

When the Draw Continuous tool is active, bonds can only be drawn from the highlighted atom.  To highlight an atom, click on it.  This mode is very convenient for “sprouting” new atoms from a selected atom.

Click the Draw Continuous button � on the Structure toolbar.  Alternatively, you can press the right mouse button to switch to this drawing mode.

Make sure that the Fluorine button � is selected on the Atoms toolbar.

Click on the right-most carbon in the drawn structure to select it.  Click the second time to sprout fluorine from the selected carbon.  Click twice on the same carbon again to sprout the second fluorine atom:�				�EMBED Unknown���

Using Mouse Drag

With either drawing tool, Draw Normal � or Draw Continuous �, dragging the mouse from one atom to another draws a single bond between them.  If you drag to or from an empty space, a new atom is inserted at the start or at the end of the drawn bond.

With either the Draw Normal or Draw Continuous tool active, point the mouse arrow to one of the terminal carbons and drag to another terminal carbon to draw the following structure:

�EMBED Unknown���

“Cleaning” the Structure

Click the Clean button �EMBED Unknown��� on the Structure toolbar to standardize all the bond lengths and angles in the drawn structure to obtain the following: �EMBED Unknown���

The Clean command not only standardizes all bond lengths and angles to make the structure look nice — it makes the drawn structures closer to being chemically correct.  For acyclic fragments, for example, it places the bonds near the sp2 carbons at 120o angles and the bonds near the sp carbon at 180o (linear).  If you draw geometrical and stereoisomers, the "Clean" command standardizes their bond lengths and angles while retaining all of their structural significance.

Using the Stereo, Coordinating and Undefined Bond Tools

You can draw a wide variety of bonds, besides the “ordinary” connection:

stereo bonds directed away from you �;

stereo bonds directed towards you �;

coordination bonds �;

and undefined bonds �.

Select any of these tools and click on any bond in the drawn structure.  Click repeatedly on a stereo or coordination bond to change its direction.

Editing Atom Labels

The Edit Atom Label tool � allows you to substitute terminal atoms with shorthand abbreviations.

Click the � button on the Atoms toolbar and then on the right-most fluorine atom in the drawn structure.

In the Edit Label dialog type (CH2)3Ph and click the Insert button.  Note that the label is inserted in the desired position and the indexes are automatically subscripted:

�EMBED Unknown���

Select the Change Position tool � and click on the label to invert it:�					�EMBED ACD.ChemSketch.20���

If you click on the label with the Change Position tool active while holding down the SHIFT key, the connection point of the label will be changed.

With the active Edit Atom Label tool click on the obtained shorthand abbreviation to open  the Edit Label dialog box again.  Then click on the Expand button to obtain the following structure:

�EMBED ACD.ChemSketch.20���

Using the Draw Chains Tool

Using the Draw Chains tool, you can easily draw short or long chains with a single click and mouse drag.

Click the Draw Chains  button �EMBED Unknown��� on the Structure toolbar and point the mouse arrow to the atom indicated by the arrow:

�EMBED Unknown���

Press mouse button and drag to the left side.  As you move the mouse away from the structure, a carbon chain is created.  Note the carbon counter (C #) located beside the mouse arrow changes with each carbon added or removed.  Continue until the counter reaches C 8, then release the mouse button to finish the chain:

�EMBED Unknown���

With the active Draw Chains tool select the Fluorine button � on the Atoms toolbar and click on the left-most carbon to sprout three fluorine atoms.  Then click on the Clean button �EMBED Unknown��� on the Structure toolbar to obtain the following structure:

�EMBED ACD.ChemSketch.20���

Flipping Structures

You can rotate or flip the structure(s) by using the following buttons:

Button�Function����Select this button and then click on the bond to set it horizontally, rotating the rest of the structure correspondingly.����Select this button and then click on the bond to set it vertically, rotating the rest of the structure correspondingly.����Flips the structure around the clicked bond.����Flips selected structure or fragment (or if nothing is selected, all drawn structures) from top to bottom.����Flips selected structure or fragment (or if nothing is selected, all drawn structures) from left to right.���

Applying the Flip tool might change the stereo configuration. To control this, from the Options menu select Preferences and switch to the Structure tab. At the bottom of the panel there is the Keep Stereo Configuration on Flips field:�	��It controls whether the program will remember the “true” 3D arrangement of the molecule.  We recommend that Flips be selected.  In this case, the molecule before is the same as the molecule after the flip, although its representation has changed:�			�EMBED ACD.ChemSketch.20����In the “No” case, the molecules before and after the flip are enantiomers:�			�EMBED ACD.ChemSketch.20���

Selecting, Rotating, and 3D Rotating

You can select atoms, bonds and fragments in two different ways, by using the second-row buttons.  Take a moment and try them out on the molecules you have sketched so far:

the Lasso Selector � or 

the Rectangle Selector �.

Once the fragment(s) has been selected, there are three ways you can move it: 

Move �EMBED Unknown��� , 

Rotate/Re-size � , 

3D Rotate  �EMBED Unknown��� , 

or you can perform one or more other operations on it:

Delete � , 

3D Optimization �EMBED Unknown���.  or 

2D Optimization (or Clean) �EMBED Unknown���.

Output

As soon as you have drawn one or more structures you may save them in a file or print them or insert them into other applications such as MS Word, Excel, etc.  You can also use the drawn structure(s) to try out the I-Lab services (refer to Chapter 4).

Saving a ChemSketch (SK2) File

Let us save the document with the structures created in previous sections in the default proprietary ACD format,� as a file which we will call chapter3.sk2.

From the File menu choose the Save button.

In the dialog box that appears, specify the name of the file and the directory where the file should be placed.  Click OK.

Saving a Structure into a Molfile

A standard format shared by many programs is the molfile format, developed by MDL, Inc.  Note that it will not retain graphical images, text etc.  It only retains the molecular structure.

Select the structure you want to save as a molfile.

From the File menu choose the Export… command.  At the bottom of the dialog box that appears make sure that MDL MOL-file (*.mol) is selected:

�

Specify the name file and directory for the file and click OK.

ACD/ChemSketch of version 4.5 can export into following file formats:�	Windows Bitmap (*.bmp, *dib),�	Windows Metafile (*.wmf),�	Paintbrush (*.pcx),�	TIFF Bitmap (*.tif),�	GIF Bitmap (*.gif),�	MDL MOL-File (*.mol),�	ISIS/ Sketch BIN-file (*.skc),�	CS ChemDraw CHM-file (*.chm),�	REACCS RXN-file (*.rxn).



Printing from ChemSketch

Before starting to print you may wish to verify the page setup settings.  From the File menu choose Page Setup… to display the dialog box where you can specify the paper size, orientation, margins for the page and if you wish set options for the poster (more details on the poster creation can be found in Section 8.7):

�

Click OK to save settings.

Click the Full Page button � to see how the page will look in a printout.

If necessary move the objects on the page to arrange them properly.

From the File menu choose Print or click � to display the Print dialog box where you can specify the number of copies to be printed. Click OK to start printing.

Embedding the Structure in a Document

Sometimes you need to insert the structure into your report written in the applications other than ChemSketch (e.g., Word document, Excel spreadsheet, etc.).

Select the required structure or several structures.

Click � or choose the Copy command from the Edit menu or press CTRL+C on your keyboard to copy the selection to the Clipboard.

Switch to the application where you want the structure(s) to be inserted and paste using the Paste function of that application.

When pasting structures copied from ChemSketch to other applications (e.g., Microsoft Excel), the structure may be represented as a set of numbers and figures (as a MOL file).  To place a picture of the structure, use the Paste Special feature in the application you are pasting to.  Among the paste options choose either the ACD ChemSketch 2.0 Object or Picture option.  The former inserts the structure as an OLE object thus allowing you to edit the inserted structure via ChemSketch by double-clicking on the picture.

Clearing the Screen

To clear the screen, you can do one of the following:

Choose the New command from the File menu to open a new document.  You will be prompted to save your changes.

Choose the New Page button � from the upper left set of buttons to insert a new empty page.

Choose the Select All command from the Edit menu and then choose the Delete command.

Click the Delete button � on the General toolbar.  Click on an empty space away from the drawn structure to select all of the structures, then click on any structure to delete the entire screen.



�Getting Started with ACD/I-Lab

Objectives

Now that you have learned how to draw molecules in ChemSketch, we want you to get a taste of what you can do with them!

This chapter will give you the basics of how to work with I-Lab (short for “Interactive Lab”) via the ChemSketch interface. It does not provide a thorough description of all the options and functions; it just gets you started. You will learn:

what the ACD/I-Lab is and what you require to use this service;

how to set options in case you are connected to the Internet via the firewall or proxy;

how to access I-Lab as a guest;

what the demo key is and how to obtain it;

how to register at I-Lab;

how to activate your account;

how to log in; and

how to calculate a property.

We use the IUPAC Name Free service as an example calculation.

Overview

ACD/I-Lab is an Internet-based service that allows you to get instant access to the ACD chemical databases and property predictions programs via the Internet.  I-Lab includes both fee-based and free services.  I-Lab registration and membership are free.

In order to use ACD/I-Lab resources with ChemSketch, you should have:

A direct Internet connection (access to http://www.acdlabs.com and http://www2.acdlabs.com addresses, at least) from the PC where you have ChemSketch installed,

An e-mail address,

ChemSketch ver. 4.0 or later with the I-Lab Add-in installed. 

If the I-Lab Add-in is already in place, when you start up ChemSketch, you will see the standard ChemSketch interface with the additional I-Lab menu on the menu bar:

�EMBED Unknown���

and the additional I-Lab Login button (replaced by the I-Lab button as soon as you log in) on the left part of the status bar:

�

If you have purchased ACD/ChemSketch 4.5, the I-Lab Add-in will likely be present (it is set up to be installed during regular installation of the software).

If you do not see the I-Lab menu, for example, if you have ChemSketch freeware, or turned off this option during installation of your purchased copy, you can download the Add-in for free from http://www.acdlabs.com/download/ilab_addon.html. Install the Add-in to the same directory where ChemSketch is installed.

Connection Options

If your computer has free access to the Internet, please skip this section.

If your computer is on a computer network protected by a firewall or proxy server, then there are some extra settings required before you can use ChemSketch to access the I-Lab.

From the I-Lab menu shown above, choose Options…

�

Fill in the Host Name of HTTP Proxy: and Port: boxes for your network.  This information can be obtained from your network administrator.

If you get error messages with “Request failed (403) or Request failed (407)”, this means that you cannot access I-Lab via your secured proxy server.  The proxy server requires user authentication (entering a login/password).

Unfortunately, the current I-Lab Add-in for ChemSketch does not have any features to handle this authentication method.  In this situation you will only be able to access I-Lab via a Web browser.  Most of the browsers provide the necessary features.  We hope to have the proper proxy authentication available in the next version of ChemSketch.

�Guest Access

The fastest way to have a look at how I-Lab works is to use the Guest Access.  In this case, you don't have to register.  As a Guest User, you can view the list of available services but can only use the IUPAC Name Free service.

Choose the Login command from the I-Lab menu

OR click the I-Lab Login button on the status bar (see above).

In the dialog box that appears, click the Guest Login button.

Wait for some time (depending on the speed of your Internet connection) until the Welcome message appears.  

Click OK to close the dialog box (or you may click the News button to view the Web page with the latest news from I-Lab).

Now you can view the available services (click the I-Lab button on the status bar or choose the I-Lab menu) and use the IUPAC Name Free service. 

Perform Calculations

As soon as you are logged in (either as a registered user or as a guest), you may start calculations.  In the current section we are going to describe how to use our free service—IUPAC Name Free.

First, you should draw a structure for which the name should be generated.

Make sure you are in Structure mode and, using the ChemSketch tools introduced in�Chapter 3, draw the structure of interest. For example,

�EMBED ACD.ChemSketch.20���

If there are several drawn structures in one page, select the one you want to name.

Make sure you are logged in.  Check the left part of the status bar.  It should contain the I-Lab button and the “traffic lights” should appear dimmed:�			Before Login:				After Login:�			� 			�

The box showing the amount of money you have in your account (if displayed with black) or the amount you owe (with yellow) is not displayed if you are connected by a Site License or as a Guest User.

�Click the I-Lab button and in the menu panel that appears find Naming > IUPAC Name Free:

�

A dialog box appears, informing you that no additional parameters are needed.  (For other properties, this dialog box may contain other information or options.)

Click OK and the next dialog box prompts you to confirm your request and to inform you of the fee (“free” in the present case). 

�

Click Yes. As soon as your request is processed, the dialog box with the results appears:

�

If the Show results on receiving check box is not selected in the ACD/I-Lab Options dialog box (I-Lab menu > Options…), the results dialog box is not displayed, but you can view the results in the Task Manager (I-Lab menu).

To create the report on the generated name, choose the Insert button. The drawn structure, the generated name, and the I-Lab calculation information are laid out on a separate page in the ChemSketch Window:

�

To refer to an I-Lab calculation in an article, a phrase is suggested in the output page.

To return to the previous page of structures, use the arrow button on the status bar (bottom).

Demo Keys

If you like what you’ve seen during Guest access and IUPAC Name Free calculation, consider moving on to the next step:  a demo key.

Demo keys allow you to try out the I-Lab services for a limited period of time.  During this demo period, you will have access to all of the I-Lab services free of charge.  After the demo period expires, your I-Lab account will be charged on a per transaction basis.

Demo keys are for a two-week (14 days) period.  A distributor or sales representative may request a demo key on behalf of a client for longer periods of time. Please contact the I-Lab Administrator directly.

Demo keys must be generated by the I-Lab Administrator.  When a demo key request comes in, it requires human intervention.  It is not an automated process like the account activation key generation.

Only one demo key is issued per account per year.  Typically the demo keys are given to newly opened accounts.  The demo keys must be requested.  They are not applied automatically.

Demo keys only have to be applied once!  They do not have to be entered every time to gain demo access. Once it has been successfully applied to the account, the user just has to login normally.

If there are problems applying a demo key to an I-Lab account, the I-Lab administrator can manually set up the demo period for the account.

To Obtain the Demo Key

Make sure you are not logged in to I-Lab.  If you are, choose Log Out from the I-Lab menu.

Choose the Request Demo Key… command from the I-Lab menu.  Your default mail client will be activated with the standard request message.  Read the message, add the required information and send it.

If the mail client cannot be automatically started, you can send an e-mail message manually to ilab@acdlabs.com with the subject something like “Send me a Demo Key” and providing your name and phone number. Please note that, by requesting the demo key, you acknowledge that I-Lab is a commercial service and after your demo period expires, you agree to pay for the I-Lab services.

The message containing the Demo Access Key will be sent to you via e-mail after some time, likely during the next working day.  In that message you will also find the instructions on how to activate the key.

Registering

To be able to work with the commercial services of I-Lab and to be able to use the Demo Key you should first register at I-Lab and then set up your own account.

If you are logged in to I-Lab as a Guest, log out by choosing Log Out from the I-Lab menu.

Choose the Register at I-Lab command from the I-Lab menu. The following dialog box appears:

�

If you do not have the Demo Key available (refer to Section 4.6 for more details), clear the �I want to use my Demo Key check box and click OK.

If you want to use your Demo Key, select the corresponding check box. In this case the registration procedure described below will be slightly different: some additional dialog boxes asking you to provide the Demo Key will appear.

Read the license agreement that appears next and, if you agree with its terms, choose Agree.

�The next dialog box will ask you if you are already registered at the ACD Web site.  If you are going to use the commercial services, it’s recommended to choose No… even if you are registered at the site, since the details you provided for the Web site may not be enough. Click OK.

�

The ACD/I-Lab Account Registration Form appears where you should specify your details.  Items marked with the red dot are required fields:

�

When you click OK, you are asked to re-enter your password and are shown the information you have just entered. Check the details and if everything is correct, click OK.

An e-mail message will be sent automatically to the e-mail address you provided.  The message will have the subject “Your ACD/I-Lab activation key” and should contain the activation key, as well as remind you of your login and password.

Activating Your I-Lab Account

Once you have registered and received the activation key you must activate your account.

From the I-Lab menu choose Activate Account… to display the following dialog box:

�

Type the login and activation key you received in the e-mail message. Click OK to start activation.

You can copy and paste the activation key from your e-mail message directly into this dialog.

You should get a confirmation that the activation key was applied successfully.  Your I-Lab account is now ready to be used.  This is the only time you need to use the activation key.

Logging In

As soon as you register and activate your account you can log in.

From the I-Lab menu choose the Login command or click the I-Lab Login button on the status bar.

In the dialog box that appears type your login name and password.

In case you want to log in as a guest, simply click the corresponding button without providing login and password.

Click OK.  The confirmation dialog box will appear when you are successfully logged in to the I-Lab.

If connection is not possible, an error message will appear in the dialog box.  You may have to try again later.

Go to Section 4.5 and, if you like, try another IUPAC Name Free calculation.  

You are ready to select any one of the available calculations.  Choose the service you would like from the I-Lab menu.  Remember that a “Confirm your request” dialog box will appear, in which you can select No, if you decide not to proceed.

�Drawing More Complex Structures

Objectives

Now that you have studied the basics of structure drawing described in Chapter 3, and have seen how the structure can be used as input for Web-based calculations in Chapter 4, you may want to draw more complex structures using advanced tools of ChemSketch.

In this chapter you will learn how to:

use the Table of Radicals for drawing typical chemical fragments;

quickly draw ring structures;

delete and replace atoms;

set double and triple bonds;

set an atom’s charge, draw cations and anions; and

change various atomic properties.

Using the Table of Radicals

The Table of Radicals includes pre-drawn structures of amino acids, their protecting groups, as well as nucleotides and other frequently used radicals.

Clear the screen using the directions given in previous section.

Click on the Table of Radicals button � on the References toolbar to display the radicals:�		�

Click the Cyclohexane button � in the Table of Radicals.

A Cyclohexane button is now located and currently selected on the References toolbar on the right side of the screen.

Repeat these steps for the Cyclopentane button �.

When you select new radicals from the Table of Radicals, the corresponding buttons are automatically added to the References toolbar.  To remove these buttons from the References toolbar, double-click on any of them or double-click on the References toolbar and choose Yes.

Using Ring Structures

Select the cyclopentane� button on the References toolbar on the right side�OR select it from the Table of Radicals.

Click on the screen to create a five-membered ring.

On the same toolbar, select the �  icon.  Now point the mouse arrow to highlight  the indicated bond, �EMBED Unknown��� and click to create the following structure: �

Repeat these steps to create the following structure; �EMBED Unknown��� 

Click the Set Bond Vertically  button � then click on the indicated bond �EMBED Unknown���to rotate the structure around this bond to obtain the following: �

Click the Table of Radicals button � on the References toolbar.

In the Table of Radicals window, select the carboxyl group �EMBED Unknown��� by clicking the � button.

Click on the atoms indicated in �to sprout carboxyl groups from them:

�

Deleting Atoms and Fragments

Delete the atoms indicated by arrows in �EMBED Unknown��� to draw �

You can do this in two ways: delete each atom individually (covered in Section 3.2.3) or delete several atoms simultaneously.  

Deleting Several Atoms Simultaneously

Click the Lasso On/Off button � on the Structure toolbar to enable the Lasso selection mode �.  Note the Select/Move tool becomes active.

Drag to include all of the specified atoms in the closed Lasso line to select them:

�EMBED Unknown���

The dotted path in this picture shows the suggested path enclosing the desired groups, and it will not appear as such in your workspace.  On the atoms within the lassoed space are selected.

Click on the Delete button � on the General toolbar.

Click on any one of the simultaneously highlighted atoms to delete all of them simultaneously.

You can select atoms, bonds and fragments in two different ways, by using either the Lasso selector � or the Rectangle selector �.  To deselect fragment(s), click anywhere on an empty space.

Replacing Atoms

Replace the atoms indicated with arrows in  �EMBED Unknown��� to draw  �EMBED Unknown���

Click the Nitrogen button � on the left Atoms toolbar and then click on all the carbons denoted by an open-head arrow on the above structure.

Click on the Oxygen button � on the Atoms toolbar and then click on three Carbons denoted by a solid-head arrow.

You cannot replace atoms with the Draw Continuous tool (see Section 3.2.6).

Setting Double and Triple Bonds

With any one of the Draw Normal �, Draw Continuous � or Draw Chains � tool active, click on the bonds indicated in �		�EMBED Unknown��� to set double bonds:  �EMBED Unknown���

Using the Change Double Bond or Hydrogen Position button � the structure’s appearance can be “fine-tuned”.  Select this button and click on the indicated hydrogens and double bonds.  Note the movement of hydrogen around the nitrogen and oxygen, and the double bond around the single bond:�				�EMBED Unknown���

You can set a double or triple bond or reset a single bond by repetitive clicking on a chosen bond.  This will cycle through all bond orders available.  When an atom has an invalid number of bonds, a corresponding charge is placed on it and it is crossed out with a red “X”: �				��If you want to disable the crossing-out function, select the structure, choose Structure Properties from the Tools menu, clear the Cross Out Invalid Atom check box in the Common tab and click Apply.

Setting Charges and Defining Anions and Cations

In this section we will draw the following set of structures:

�EMBED ACD.ChemSketch.20�����EMBED ACD.ChemSketch.20�����EMBED ACD.ChemSketch.20������cation�anion�free radical����EMBED ACD.ChemSketch.20�����EMBED ACD.ChemSketch.20�����EMBED ACD.ChemSketch.20�����EMBED ACD.ChemSketch.20�����radical cation�radical anion�singlet biradical�triplet biradical��

Choose the Carbon button � on the Atoms toolbar and make sure that the Draw Normal tool � is on.  Click three times in one place to draw the following structure:�					�EMBED ACD.ChemSketch.20���

Choose the Nitrogen button � and click on the middle carbon in the fragment to replace it with a nitrogen:�					�

Click the bottom right triangle of the � button on the left Atoms toolbar to expand it to the following group:�	�	Increment Charge;�	�	Decrement Charge;�	�	Radical;�	�	Radical Cation;�	�	Radical Anion.

Click on the Decrement Charge button � and then click on the NH group to make an anion:�					�EMBED ACD.ChemSketch.20���

Right-click to switch to the Increment Charge tool (or choose � from the group of buttons) and click twice to make a cation:�					�EMBED ACD.ChemSketch.20���

When you use the Charge buttons, � or � , to change the charge of a non-metal, the corresponding number of hydrogen atoms is automatically added to it, or removed from it, to preserve proper chemical valency.  If you change the charge of a metal, the charge is changed in increments or decrements in accordance with the next chemically valid charge of the corresponding ion.  (You can view common valences used in the Periodic Table of the Elements.)

Choose the Radical button �  from the group of buttons shown in step 3 above and click on the NH2 group to draw a free radical:�					�EMBED ACD.ChemSketch.20���

Right-click in an open part of the workspace to quickly switch to the Radical Cation tool or choose the corresponding button � and click to draw the radical cation:�					�EMBED ACD.ChemSketch.20���

Right-click in an open part of the workspace to switch to the Radical Anion tool � and click to draw the radical anion:�					�EMBED ACD.ChemSketch.20���

Choose the Delete button � on the top General toolbar and click the right CH3 group to delete it.

From the group of buttons in step 3 choose the Radical tool � and click on the NH group several times until the following singlet biradical is obtained:�					�EMBED ACD.ChemSketch.20���

Continue clicking with the radical tool until the triplet biradical is displayed:�					�EMBED ACD.ChemSketch.20���

Changing Atom Properties

If you want to display the valency or the isotopic mass of the atom in a ChemSketch structure—or even change the typeface or the size of the atom—you should use the Properties panel.

Click the Select/Move button �.

Double-click on the atom whose displayed properties you want to change.  This will make the Properties dialog box appear.  Switch to the Atom Properties tab:�				�

Clicking the buttons � displays options for changing

C – atom symbol,

H – attendant hydrogens,

n – index of the attendant hydrogens,

q – charge,

V – valence,

I – isotopic mass,

N – numbering of atom in the overall molecule.

As you set the values, click Apply to have the change appear immediately on the selected atom.

�Advanced Structures and Reaction Schemes

Objectives

This chapter is the next step to drawing even more sophisticated structures.  Two kinds of optimization are covered:  optimizing for display purposes (2D) and optimizing according to a simple force-field model (3D).  If you are using ChemSketch for the first time, it is recommended that you do the exercises described here only after completing the previous chapters.

In this chapter you will learn how to:

draw structures of cyclic Alkanes and Peptides using the 2D optimization (Clean Structure) tool;

use the 3D Optimization tool for drawing “spectacular” 3D structures of Bicyclo[2.2.2]octane, tripticene, cubane and dodecahedrane;

draw reaction schemes.

2D Optimization

The Clean option can be considered to be a 2D-optimization of the drawn structure, i.e. re-drawing and re-sizing it to standardize all the bond lengths and angles.  Using this option you can easily draw a structure perfectly.  Some examples:

Creating the Structure of Cyclic Alkanes

(( This section is based on the movie cycloalk.exe which can be downloaded from our Web site or found in the Movies folder.

Using the following technique you can quickly draw cyclic alkanes perfectly.  Here's how to draw Cyclononane:

�

Switch to the � mode and delete any previously drawn structures by pressing CTRL+A and then DELETE.

Choose the Draw Chains tool � and drag in the workspace to draw a 9-member chain.  Note that the informative cursor shows the number of atoms in the chain.�				�

Right-click to quickly switch to the Draw Normal tool � and drag from one end atom to another in order to connect them with a bond.�			�

Click on the Clean Structure � button to obtain the following structure:�					�

�	Try to draw C10- and C8-rings using the above technique.

Creating the Structure of a Cyclic Peptide

(( This section is based on the movie pept.exe which can be downloaded from our Web site or found in the Movies folder.

Let’s draw the cyclic Tyr-Ala-Trp.  Again we will find the Clean Structure button is useful.

�

Switch to the � mode and delete any previously drawn structures by pressing CTRL+A and then DELETE.

From the Template Window � choose the � tab.

From the set of amino acids, choose Tyrosine and click in the workspace to copy the structure.

From the Table of Radicals � choose Alanine � and then Tryptophan � and click on the indicated atoms to attach the corresponding radicals:�	�

You will need to flip the template shadow before placing it in the workspace by pressing the TAB key.

Right-click to quickly switch to the Select/Move tool � and drag the NH2 group to the OH group as shown:�		�

Click on the Clean Structure � button to obtain the following structure:�				�

�	Try to draw any other cyclic peptide, for instance Gramicidine S:

�

3D Optimization

This section explains how to create structures that have “realistic” angles and bond lengths.  There is no need to explain how difficult it is to draw such molecules proportionally.  The 3D-Optimization and 3D Rotation options will help you to quickly cope with this task.  These options make it possible to create complex structures in ACD/ChemSketch with ease.

The 3D optimization algorithm is a proprietary version of molecular mechanics with the force field initially based on CHARMM parameterization�.  The modifications involve some simplification and were intended to increase the stability and speed of computation.  Note that 3D-optimizer is NOT a full-scale molecular mechanics engine.  Its design aims to reliably reproduce reasonable conformations from (possibly very unreasonable) 2D drawings, rather than to precisely optimize 3D structures.

If 3D-optimizer produces the conformation different from what you have expected, do not be surprised.  It is the very essence of conformational analysis that molecules typically have many conformations.  The optimizer finds only one, and it may not be one you expect.  For example, you probably expect a cyclohexane fragment to be a chair, but the optimizer may generate twist-boat, which is also one of its suitable conformations (indeed, in many structures this fragment exists in a twisted form).  In such a case, you may try to correct the conformation (e.g., by manually moving the atoms into desired direction and 3D-optimizing the structure again).

You may wish to perform actual conformational analysis of your molecule using a special molecular mechanics or quantum chemistry geometry optimization package.  The ChemSketch 3D-optimized structure will serve as input data.

Creating Structure of Bicyclo[2.2.2]octane

(( This section is based on the movie bicyc.exe which can be downloaded from our Web site or found in the Movies folder.

�

Switch to the � mode and delete any previously drawn structures or move to a new page.

From the Options menu, select Preferences and switch to the Structure tab.

Clear the Add Hydrogens check box.

From the Table of Radicals � choose Cyclohexane �.  Click in the workspace to place a cyclohexane ring.

Click the Draw Normal tool � and draw the hydrocarbon bridge by dragging as shown in the following scheme:�		�

Click the 3D Optimization � button to obtain a 3D model of the drawn structure.

If there is more than one structure in the workspace you should select the structure you want to 3D-optimize using any of the selection tools (Select/Move �, Select/Move/Re-size � or 3D Rotation � tools).

If the Switch to 3D Rotation mode check box in the Structure tab of the Preferences dialog box (Options menu) is selected, you will be automatically switched to 3D Rotation mode after the 3D Optimization is completed.  If you are not, switch to the 3D-Rotation tool �.  Place the mouse cursor over any atom or bond in the structure and drag the mouse over the workspace to rotate the structure until it is placed as shown:�					�

�From the Options menu, select Preferences and click on the Structure tab of the dialog box.  You can choose whether the background bond should be broken or not by selecting or clearing the Enable bonds intersections check box.��You can change the position of intersecting bonds by applying the Bring Bond to Front (CTRL+F) or Send Bond to Back (CTRL+K) commands (Tools menu) to the selected bond.  You can also bring the background bond to the front by clicking on it with the Change Position � tool active while holding down the SHIFT key.

�EMBED Unknown���	Try to draw the following structures on your own using the above technique 

��

Bicyclo[2.2.1]heptane����

Bicyclo[4.2.1]nonane��Creating the Structure of Triptycene

(( This section is based on the movie triptyc.exe which can be downloaded from our Web site or found in the Movies folder.

�

Switch to the � mode and delete any previously drawn structures or move to a new page.

Draw the structure of bicyclo[2.2.2]octane as described above or use the corresponding template from the Template Window � on the Structure toolbar (the � tab).

From the Table of Radicals � choose Benzene �.

Position the cursor over the bond a and click to attach the benzene ring to this bond:�				�

Repeat steps 2--3 for bonds b and c to obtain the following structure:�					�

If there is more than one structure in the workspace, select the structure you want to 3D-optimize using any of the selection tools (Select/Move �, Select/Rotate/Re-size � or 3D Rotation � tools).

Click on the 3D Optimization � button to obtain a 3D-model of the drawn structure:�				�

If the Switch to 3D Rotation mode check box in the Structure tab of the Preferences dialog box (Options menu) is selected, the program will automatically switch to 3D Rotation mode after the 3D Optimization is completed, if it does not, select the 3D Rotation tool �.  Place the mouse cursor over any atom or bond of the structure and drag the mouse over the workspace to obtain the projection you want.

Choose the Show Aromaticity command from the Tools menu to show the aromatic rings:�				�

Creating the Structure of Cubane

(( This section is based on the movie Pr_cub.exe which can be downloaded from our Web site or found in the Movies folder.

�

Switch to the � mode and delete any previously drawn structures or move to a new page.

From the Table of Radicals � choose Cyclobutane �.  Click twice in the workspace to place two 4-membered rings one under another.

�Choose the Draw Normal tool � and connect the corners of cyclobutane molecules with bonds by dragging from one atom to another as shown:�	�

Click on the 3D Optimization � button to obtain the 3D model of the drawn structure.

Select the 3D Rotation tool � if it is not already selected.

Place the mouse cursor over any atom or bond of the structure and drag the mouse over the workspace to obtain the projection you want:

�

From the Options menu, select Preferences and click on the Structure tab of the dialog box.  You can choose whether the background bond should be broken or not by selecting or clearing the Enable bonds intersections check box.��You can change the position of intersecting bonds by applying the Bring Bond to Front (CTRL+F) or Send Bond to Back (CTRL+K) commands (Tools menu) to the selected bond.  You can also bring the background bond to the front by clicking on it with the Change Position � tool active while holding down the SHIFT key.

�	Try to draw the following structures on your own using the above technique 

��Prismane����Hexacyclo[4.2.0.02,5.03,9.04,8.07,10]decane��Creating the Structure of Dodecahedrane ([5]Fullerene-C20)

(( This section is based on the movie fuller.exe which can be downloaded from our Web site or found in the Movies folder.

�

Switch to the � mode and delete any previously drawn structures or move to a new page.

From the Table of Radicals � choose Cyclopentane �.  Click in the workspace to place a cyclopentane ring.

Consequently position the mouse pointer over every bond of the ring and click to attach five other rings:�		�

Right-click to quickly switch to the Select/Move tool �.

Move by dragging atoms a, c, e, g, i to atoms b, d, f, h, j accordingly as shown in the following scheme to merge them:�			�

Select the Carbon button � on the left Atoms toolbar and click directly on the points indicated by arrows to add more atoms and bonds:�		�

Connect the adjacent methyl groups with single bonds by dragging from one terminal atom to another to obtain the following structure:�				�

Click on the 3D Optimization � button to obtain the 3D model of the drawn structure.

If the optimization produces a “Moebius” structure instead of a fullerene-type structure 						��the optimization has converged to an unusual value.  Use the Undo button to return to your pre-optimized structure.  Then, apply the Clean Structure tool or, using the Select/Move tool, move some of the atoms slightly and optimize again.

Select the 3D Rotation tool �.  Place the mouse cursor over any atom or bond in the structure and drag the mouse over the workspace to obtain the projection you want.�		�

From the Options menu, select Preferences and click on the Structure tab of the dialog box.  You can choose whether the background bond should be broken or not by selecting or clearing the Enable bonds intersections check box.��You can change the position of intersecting bonds by applying the Bring Bond to Front (CTRL+F) or Send Bond to Back (CTRL+K) commands (Tools menu) to the selected bond.  You can also bring the background bond to the front by clicking on it with the Change Position � tool active while holding down the SHIFT key.

�	Try to draw the following structures using the technique described above

��

[4,6]Fullerene-C24

���

[5,6]Fullerene-C24��Drawing a Reaction Scheme

(( This section is based on the movie reaction.exe which can be downloaded from our Web site or found in the Movies folder.

In this section we will draw the following reaction scheme:�		�EMBED ACD.ChemSketch.20���

From the Table of Radicals � choose Benzene � (if you have previously used this template recently, it can found in the right Reference toolbar).

Press the TAB key to flip the template shadow and draw the following structure by clicking in the workspace several times:��

To draw a fused-ring structure, place the cursor directly over a ring bond and click.

Press TAB to flip the shadow again and click beside the drawn structure to place a separate ring.  Right-click to hide the template shadow.�			�EMBED ACD.ChemSketch.20���

Click the Draw Normal tool on the upper Structure toolbar and click on the bond of the ring to make it triple:�					�

Draw the structure of Triptycene as described in Section 6.3.2 and place it beside the other drawn structures:�			�EMBED ACD.ChemSketch.20���

From the Structure toolbar choose the Reaction Plus tool � and click between the first and the second structures to place it:�		�EMBED ACD.ChemSketch.20���

Click the Reaction Arrow tool � and click or drag to place it as well:�		�EMBED ACD.ChemSketch.20���

By clicking the bottom right triangle of the Reaction Arrow button you can choose among various type of arrows.  Some arrows are treated as graphical objects, however, and may not export properly.

To move the plus sign or the arrow, click the Select/Move tool �, point to the object and drag.



�Advanced Drawing: Templates

Objectives

This chapter brings you yet another step closer to advanced drawing expertise once you have mastered the powerful Template feature.  You will learn:

some ways template usage can help you;

how to apply the Instant Template tool for drawing structures containing repetitive fragments;

more ways of using the Table of Radicals;

how to use the Template Window for drawing DNA molecules and complex biomolecules;

how to create your own templates; and

what templates are available from our Web site.

Overview

ACD/ChemSketch includes the following 3 sources of structure templates:

Table of Radicals �;

Template Window �;

Instant Template tool �.

While the binding point of any template in the Table of Radicals is fixed (invariable), the Template Window and the Instant Template tool allow you to specify any atom or bond to be the binding point simply by clicking directly on it.  However, no matter what the source of template is, the principles of joining are the same.  There are several ways of joining the template to a drawn structure:

By fusing the bonds of the structure and template: point the mouse pointer over the bond so that the corresponding bonds of the structure and the template shadow are fused and then click.

By attaching the template to the structure: point the mouse pointer on the corresponding atom on the structure so that the connecting bond appears and click

By drawing a spiro connection between the template and the structure: point the mouse pointer on the atom you want to be the binding point and click holding down the SHIFT key.

You can flip the template shadow before fixing it by pressing the TAB key.

Template Window Organizer is a very convenient way for managing template files:  both those included with the software package, and those which you decide to create.  It will just take you a minute to save your document as a template and then quickly find it.  Note that the only difference between the template file and a usual file is the fact that you can find the template file in the Template Window Organizer.  Otherwise it is a usual document with the extension *.sk2.  By saving files this way there are several advantages:

Your *.sk2 files scattered over different directories and disks will be gathered in one place (the Template Window Organizer).

You can assign a name to the template that is more descriptive than what the real file name is.  This will better reflect the contents of the document and allow you to quickly find the document you need.

You can quickly find the document by previewing its contents in the Preview Field of the Template Window.

You can quickly open a selected document from the list just by clicking the Open Document button in the Template Window Organizer.

Up to 15 templates can be accessed through the Template Window.

Instant Template Tool

A useful ACD/ChemSketch feature is the Instant Template tool � which will help you save time by allowing you to draw fragments quickly.  You can think of it as a “replicate” command.

Creating the Structure of a Cyclic Oligomer

(( This section is based on the movie oligomer.exe which can be downloaded from our Web site or found in the Movies folder.

�EMBED Unknown���

Switch to the � mode and delete any previously drawn structures by pressing CTRL+A and then DELETE.

From the Table of Radicals � choose Benzene �.  Point the cursor to the upper middle part of the workspace and click to place a benzene ring.

From the Table of Radicals choose Ethynyl � and click on the atom indicated by the arrow to attach it to the ring:�				�

Choose the Instant Template tool � and click on the indicated atom to create an instant template�					�

Click on the atom indicated by the arrow to attach the template:�			�

Click � again and click on the atom to create the template of the whole fragment:�				�

Click on the atoms to attach the template as shown.  To hide the template shadow right-click in the workspace after you finish drawing:��

Choose the Draw Normal tool � and click on the indicated atom to complete the ring:�		�

Table of Radicals in Structure Drawing

Creating the Structure of Fluorescamine

(( This section is based on the movie fluor.exe which can be downloaded from our Web site or found in the Movies folder.

�

Switch to the � mode and delete any previously drawn structures.

From the Table of Radicals � choose Cyclopentane �.  Click in the workspace to copy the ring.

Click on the indicated atom while holding down the SHIFT key to obtain the spiro-connection with the second cyclopentane ring:�			�

From the Table of Radicals � choose Benzene �.  First click on the indicated bond to fuse the benzene ring and then click on the indicated atom to connect the phenyl radical:��

Choose the Oxygen � button on the Atoms toolbar (note that the Draw Normal tool � is automatically enabled).  Click on the indicated atoms to replace them with oxygen atoms:�	�

�Right-click to quickly switch to the Draw Continuous tool �.  Double-click on the indicated atoms to attach the OH groups to them:�	�

Click on the indicated single bonds to replace them with double-bonds:�	�

Templates from the Template Window

(( A brief tour of available ChemSketch Templates is given in the movie templ_st.exe which can be downloaded from our Web site or found in the Movies folder.

Creating the Fragment of a DNA Molecule

(( This section is based on the movie dna_st.exe which can be downloaded from our Web site or found in the Movies folder.

�

Switch to the � mode and delete any previously drawn structures.

Drawing the Chain of Deoxyriboso-5-phosphate Fragments

Open the Template Window �.  From the � tab choose �2-Deoxyriboso-5-phosphate (chain form) by clicking on the indicated atom:�				�EMBED Unknown���

Click in the workspace to paste the chosen template.

Position the mouse pointer over the indicated atom and while holding down the SHIFT key click to attach the next 2-Deoxyriboso-5-phosphate fragment:�		�EMBED Unknown���

Choose the Select/Rotate/Re-size tool �.

Select the indicated part of structure by dragging the selection rectangle around it.  Drag the action center �EMBED Unknown��� onto the oxygen atom indicated by arrow.  Then holding down the SHIFT key drag the selected part of structure clockwise to rotate it by 90o:��EMBED Unknown���



Adding the Bases

Open the Template Window �.  From the � tab choose the base you need by clicking on the atom that will be the attachment point.  For example, choose uracil, clicking on the N atom shown so that this will be used as the attachment point:

�

Position the mouse pointer over the atom indicated below and click while holding down the SHIFT key:�			�

You can flip the template shadow before fixing it by pressing the TAB key.

Repeat steps 1 and 2 to add bases to other nucleotides such as adenine:�			�

�	Now try to draw your own DNA or RNA fragment of any other length.

Drawing Complex Biomolecules

Here are some examples for creating complex biomolecules using different ACD/ChemSketch tools.

Creating the Structure of b-Maltose

(( This section is based on the movie maltose.exe which can be downloaded from our Web site or found in the Movies folder.

�

Switch to the � mode and delete any previously drawn structures.

In the Template Window � select the � tab, and confirm that you are viewing the Haworth formulae page: �.  If not, click on the arrow to the right of the text box and choose accordingly.

Click once on (-D-Glucopyranose to select it and click in the workspace to copy it.

Repeat steps 1-3, but this time select the beta-D-pyranose tab � and choose (-D-Glucopyranose 

Click in the ChemSketch Window to place it to the right of the first structure.�				�

Choose the Carbon button �.  Click on the indicated atom in the (-D-Glucopyranose structure to replace it with a CH3 group and then drag from the CH3 group to the right while holding down the SHIFT key to draw the bond at a perfect right angle:�		�

Repeat step 3 for the (-D-Glucopyranose structure to obtain the following structure:�		�

Choose the Oxygen button � and click on the indicated atom in the (-D-Glucopyranose structure:�			�

Choose the Select/Move tool �.  Click in the workspace adjacent to, but not touching, the (-D-Glucopyranose structure to select it.  Place the mouse cursor over any atom or bond of the selected structure and drag it to the left until the corresponding OH and CH3 groups overlap each other:�		�

If desired, hide single hydrogens in the selected structure by choosing the Remove Explicit Hydrogens command from the Tools menu:

�

Though the carbon atoms bonded to central oxygen are hidden, they are still present.  If the chemical meaning is important for your task (for example, in calculating the molecular weight) you can remove these atoms in the following way.  With the Select/Move tool � active double-click on the hidden atom.  When the Properties panel appears; click on the � tab, then on the Atom Symbol button � and from the Value drop-down list choose Empty �.  Click Apply.

�	Try to draw the following structure on your own using the technique as described above:

��

b-Cellobiose��Defining a User Template

It is very easy to assign a ChemSketch file as a Template.  As of Summer 1998, we are offering free Templates that can be downloaded from our Web site.�  To designate a ChemSketch file as a template, we recommend you place the SK2 file in the Templates folder.  Then, do the following:

Save your current structures as an SK2 file or open the SK2 file (with structures in it) in ChemSketch.

From the Templates menu choose the Save User Template command.

In the Save User Template dialog box type in the name for your template, such as “Alkaloids”, and browse to obtain the path name to your file, such as “C:\ACD45\Templates\alkaloids.sk2” and click OK.

You can enter any name for your document (e.g.  for the document b_d_fur.sk2 the following name—Sugars: beta-D-Furanose—would be more appropriate).

Once your document is saved as a user template, its name (under the entered name) is automatically added to the list of templates in the Template Organizer and Template Window (Templates menu).

You can create a user template from any document even if it is closed.  Open the Template Organizer dialog box (Templates menu), click the New...  button, find the needed document and assign it a name.

You can perform the following tasks with the user template:

Quickly find the document and open it for editing.  From the Template List (Template Organizer) choose the needed template and click Open Document button.

Copy any part of your document to the workspace (Structure or Draw mode) without opening the whole document.  To do this find your template in the Template List (Template Window) and click on the item to place it into the workspace.

The Template.cfg File

The key to management of the templates in ACD/ChemSketch is the file template.cfg.  This file lets ChemSketch know that an .SK2 file is a template file rather than simply a user file.  It can be opened and read with any text editor, although you will likely never need to do so.  The Template Window accesses “template.cfg” to let it know what files to display as templates.  If an .SK2 file is not shown in the Template Window, it will be added to “template.cfg” when you open the SK2 as a regular ChemSketch file and select the command to save as a user template.

If template.cfg is moved or lost, the Template Window will not display any templates.  If the template.cfg file is found (by Windows Explorer, for example, or the system “Find File” utility) it can be restored to the default directory or the user’s private directory.  If it cannot be found, it must be retrieved by reinstalling ChemSketch or by adding each template individually as detailed above.

Available Templates

As of Fall 2000, this is the list of templates that are included together with both free and commercial ChemSketch: You can find them in the Template folder after installation.

Contents�File Name �Comments�Sample��Alkaloids�alkaloid.sk2�5 pages, listed alphabetically by common name.�� EMBED ACD.ChemSketch.20  �����Amino Acids�aminacid.sk2�2 pages, listed as molecules and C-radicals, with names and 3-letter abbreviations.�� EMBED ACD.ChemSketch.20  �����Aromatics�aromatic.sk2�1 page, mainly 5- and 6-membered fused rings with names.�� EMBED ACD.ChemSketch.20  �����Arrows�arrows.sk2�1 page of large, curved, complex arrows.�� EMBED ACD.ChemSketch.20  ���and � EMBED ACD.ChemSketch.20  �����Bicyclics�bicycles.sk2�1 page containing structures with 2 or more cycles, most with names.�� EMBED ACD.ChemSketch.20  �����Carbohydrates�sugars.sk2�3 pages of Haworth, stereo-Fisher, and stereo projections, with names.  (See also ‘Sugars’ below.)�� EMBED ACD.ChemSketch.20  ���  and � EMBED ACD.ChemSketch.20  �����Carbonyls�carbonyl.sk2�1 page of structural fragments containing the C=O moiety; no names.�� EMBED ACD.ChemSketch.20  �����Carotenes�carotene.sk2�4 pages of conjugated alkenes with names.�� EMBED ACD.ChemSketch.20  �����C-Groups�c_groups.sk2�1 page of structural fragments, very similar to the Table of Radicals.  No names.�� EMBED ACD.ChemSketch.20  �����Chains�chains.sk2�2 pages of saturated (named) and unsaturated (unnamed) chains.�� EMBED ACD.ChemSketch.20  �����Chem Quiz�chemquiz.sk2�2 pages of text and figures, showing several sample questions drawn from other templates.��������Crown Ethers�crowns.sk2�1 page of ether cycles, 2D only, named.�� EMBED ACD.ChemSketch.20  �����DNA/RNA Kit�nucleo.sk2�2 pages of named structural components of DNA.  See also the DNA Builder of Goodies (Section 13.3).�� EMBED ACD.ChemSketch.20  �����Figures�set.sk2�1 page of assorted items like DNA strands, micelles and curlicues.�� EMBED ACD.ChemSketch.20  ��� and � EMBED ACD.ChemSketch.20  �����Fullerenes�fuller.sk2�1 page of saturated and unsaturated fullerenes.�� EMBED ACD.ChemSketch.20  �����Lab Kit�kit.sk2�1 page of some common pieces of lab equipment, not named.�� EMBED ACD.ChemSketch.20  �����Labels�labels.sk2�1 page of warning labels.�� EMBED ACD.ChemSketch.20  ��� ��Lattice�lattice.sk2�1 page of standard crystal types, named.�� EMBED ACD.ChemSketch.20  �����Monocyclic Alkanes�cycloalk.sk2�1 page of carbon rings, 3-20 in size.�� EMBED ACD.ChemSketch.20  �����Monomer Templates�monomers.sk2�3 pages of building blocks of common polymers, unnamed.�� EMBED ACD.ChemSketch.20  �����N-Containing Groups�n_groups.sk2�1 page of named structural fragments containing nitrogen.�� EMBED ACD.ChemSketch.20  �����Newman Projections�newmans.sk2�2 pages of anti, gauche, eclipsed and staggered conformations.�� EMBED ACD.ChemSketch.20  ����������N-Rings�n_rings.sk2�3 pages of named mono-, bi- and tricyclic rings containing nitrogen.�� EMBED ACD.ChemSketch.20  �����O- and S-Rings�os_rings.sk2�1 page of named mono-, bi- and tricyclic rings containing oxygen and sulfur.�� EMBED ACD.ChemSketch.20  �����Orbitals�orbitals.sk2�2 pages of s, p, d, sigma and pi large and small orbitals.�� EMBED ACD.ChemSketch.20  �����Phosphorus Compounds�phosphor.sk2�1 page of named structures containing phosphorus.�� EMBED ACD.ChemSketch.20  �����Polycyclics�polycycl.sk2�1 page of bridged, saturated and/or fused structures, with names.�� EMBED ACD.ChemSketch.20  �����Polygons�polygons.sk2�1 page of geometric solids.�� EMBED ACD.ChemSketch.20  ��� and � EMBED ACD.ChemSketch.20  �����Polylines�polyline.sk2�1 page of more geometric solids.�� EMBED ACD.ChemSketch.20  �����Reaction Symbols�reacsym.sk2�1 page of common symbols.�� EMBED ACD.ChemSketch.20  �����Rings�rings.sk2�1 page of 5- and 6-membered rings.�� EMBED ACD.ChemSketch.20  ���and � EMBED ACD.ChemSketch.20  �����SP Synthesis Resins�linkers.sk2�1 page of named resin fragments, all attached to solid phase.�� EMBED ACD.ChemSketch.20  �����Stereo Templates�conform.sk2�1 page of drawings (not structures) to show stereo conformations.�� EMBED ACD.ChemSketch.20  �����Steroids�steroid.sk2�1 page of steroids, with trivial names�� EMBED ACD.ChemSketch.20  �����Sugars: alfa-D-Fur�a_d_fur.sk2�3 pages of 5-membered sugars, with Haworth, stereo and Fisher projections, with names.�� EMBED ACD.ChemSketch.20  ���and � EMBED ACD.ChemSketch.20  �����Sugars: alfa-D-Pyr�a_d_pyr.sk2�4 pages of 6-membered sugars, with Haworth, stereo, chair and Fisher projections, with names.�� EMBED ACD.ChemSketch.20  ��� and � EMBED ACD.ChemSketch.20  ����������Sugars: beta-D-Fur�b_d_fur.sk2�3 pages of 5-membered sugars, with Haworth, stereo and Fisher projections, with names.�� EMBED ACD.ChemSketch.20  ��� and � EMBED ACD.ChemSketch.20  �����Sugars: beta-D-Pyr�b_d_pyr.sk2�4 pages of 6-membered sugars, with Haworth, stereo, chair and Fisher projections, with names.�� EMBED ACD.ChemSketch.20  ��� and � EMBED ACD.ChemSketch.20  �����Terpenes�terpen.sk2�2 pages of common terpenes, with names.�� EMBED ACD.ChemSketch.20  �����Tipped Rings�tipped.sk2�1 page of rings shown in perspective.�� EMBED ACD.ChemSketch.20  �����

�Creating Graphical Objects

Objectives

This chapter will familiarize you with the creation of graphical objects, so switch to the Draw mode before proceeding with any exercise in this chapter.

You will learn how to use Draw mode tools for creating the following objects:

a diagram of the energy of reaction;

various types of orbitals;

vacuum distillation apparatus;

a two-chain DNA strand;

lipids and micelles; and

multi-page layout posters.

Drawing the Energy of Reaction Diagram

(( This section is based on the movie diagram.exe which can be downloaded from our Web site or found in the Movies folder.�				�

Switch to the � mode and select the Polyline tool �

Drawing a Curve

Drag horizontally to the right from the starting point of the curve to stretch the control line.

Release the mouse button.

Move the mouse up to draw the first segment of the curve.

Drag horizontally to the right to stretch the control lines.  By changing the length of the control lines you can modify the curve segment.

Release the mouse button.

Move the mouse down to draw the next segment.�				�EMBED ACD.ChemSketch.20���

Repeat the above steps to draw the next two segments.

Right-click to finish drawing the curve.

When drawing with the polyline tool, it is helpful to remember a “click” will create an endpoint, a cusp, or a sharp angle, and a “drag” will create a curve:�	�		�

Modifying a Curve

The first time you draw with the Polyline tool you might have some trouble getting the curve to turn out the way you want.  For example, the first attempt might produce something like this:

�EMBED ACD.ChemSketch.20���

If the curve is not already selected, click the Select/Move tool � and then click on the curve.

Click the Edit Nodes tool �.  This will show all the nodes of the polyline that can be modified:

�

Click on the third node, and you will see the node selected and the control lines appear:

�

Move the control lines, and select and modify other nodes until the curve looks the way you want it.

When using the Edit Node tool, you can manipulate nodes using the buttons on the Node toolbar that appears.  For example, you can select several nodes by clicking on them with SHIFT and then align them by choosing the corresponding button on the toolbar.

Drawing the X and Y axes

Make sure that the Polyline tool � is switched on.

Select the Draw Arrow tool �.  In the Arrow panel from the Arrow Type drop-down list � choose the two way arrow �.

Click at the endpoint of the Y axis.

Move the mouse down vertically to draw the axis.

Click to fix the point of the axes’ intersection.

Move the mouse horizontally to the right to draw the X axis.

Click to fix the endpoint of the X axis.�			�

Right-click to finish drawing the axes.

You can easily draw the axes at a right angle by previously choosing the Snap on Grid and/or Show Grid command (Options menu).

Add inscriptions using the Text � and Rotate 90( � tools.

�	Here’s a challenge.  Use the text tool to print a word in the workspace.  Select it and change its font size to, say, 36 points, and its color to yellow.  Now use the polyline tool to write the word over top.  (Hint:  “write” the word as best as you can and then use the Edit Nodes tool liberally.)
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Drawing Different Kinds of Orbitals

(( This section is based on the movie orbital.exe which can be downloaded from our Web site or found in the Movies folder.

Switch to the � mode.

Drawing a p-orbital

To draw this orbital � do the following:

Select the Polygon tool �.

Drag horizontally to the right from the starting point of the orbital to stretch the control line.

Release the mouse button.

Move the mouse down to draw the body of the orbital.

Click to fix the orbital.�			�

If the shape of the curve is not what you want, use the Edit Nodes tool �.

Right-click twice to finish drawing the orbital and to quickly switch to the Select/Move/Re-size tool �.  Position the cursor over the selected orbital; while holding down the CTRL key drag it down to make a copy of the drawn orbital.

Choose the Flip Top to Bottom button � to flip the lower segment of the orbital.  Align the segments by moving them.

Point to the gray color button in the Color Palette (at the bottom of the workspace) and click with the left mouse button to change the fill color of the orbital segment.�			�

To quickly center the orbital segments, select them and click the Center Horizontally button �.

Select both segments of the orbital and click the Group button �.  Now you can manipulate the segments as a single object, e.g.  rotate using the Select/Move/Rotate tool �.

Drawing a d-orbital

To draw the orbital� do the following:

Select the Polygon tool �.

Drag horizontally to the right from the starting point of the orbital to stretch the control line.

Release the mouse button.

Move the mouse down to draw the body of the orbital.

Drag horizontally to the right to stretch the control lines.  Note that to make the two segments of the orbital identical, make the lengths of the control lines equal.

Release the mouse button.

Right-click to finish drawing the orbital and to switch to the Select/Move/Re-size tool �.�		�

You can draw the symmetrical orbital easier by previously choosing the Snap on Grid command (Options menu).

Select the orbital and holding down the CTRL key drag to make a copy of it.

Choose the Rotate 90( button �.to rotate the copy of the orbital.

Move the copy by dragging it.

Point to the gray color button in the Color Palette and click with the left mouse button to change the color of the orbital:�	�

To quickly center the orbitals, select them and click the Center Horizontally button �.

Select both orbitals and click the Group button �.  Now you can manipulate the orbitals as a single object, e.g. rotate using the Select/Move/Rotate tool �.

Drawing a pi-type orbital

To draw this orbital � do the following:

Select the Ellipse tool � and drag in the workspace to draw an ellipse.

From the Objects menu choose the Convert to Polyline command.

Select the Edit Nodes tool �.

Drag the lowest node up.�	 �

Right-click to switch to the Select/Move/Re-size tool �.

Select the orbital by clicking on its contour and holding down the CTRL key drag to make a copy of it.

Choose the Flip Top to Bottom button � to flip the lower orbital.

Point to the gray color button in the Color Palette and click on the left mouse button to change the color of the orbital.�	�

To quickly center the orbitals, select them and click the Center Horizontally button �.

Select both orbitals and click the Group button �.  Now you can manipulate them as a single object.

Drawing Vacuum Distillation Apparatus

(( This section is based on the movie apparat.exe which can be downloaded from our Web site or found in the Movies folder.

�

Switch to the Draw mode and set 50% zoom.

In the Template Window � choose the Lab Kit tab from the Template List.

Select the round-bottom flask by clicking on it.  Click on the workspace to place the selected template.  Then right-click to hide the template shadow.

Open the Template Window.  Select the vigreux distillation column with connecting adapter.  Connect it to flask by clicking and right-click to hide the template shadow.

From the Template Window choose thermometer and connect it by clicking as shown.  Hide the template shadow.

From the Template Window choose the distillation column and place it on the workspace near the apparatus by clicking.  Right-click to hide the template shadow and switch to the Select/Move/Re-size tool �.

Click on any selection handle (black squares surrounding the distillation column) to quickly switch to the Select/Move/Rotate tool �.

Rotate the selected object 60( counter-clockwise by dragging any selection handle.  The informative cursor will show you the angle of rotation (if the corresponding option has been selected in the General tab of the Preferences dialog box (Options menu)).  Note, that holding down the SHIFT key while rotating will constrain the angle of rotation to 15( and will help you to rotate the object exactly by 60(.

Move the column by dragging to attach it to the apparatus.

From the Template Window select the vacuum adapter and attach it to apparatus.

Complete the drawing by connecting the receiving flask.

�

�

�Annotating a Diagram

ACD/ChemSketch enables you to draw many elegant and detailed set-ups of your glassware apparatus.  The Lab Kit template has been recently updated to include burettes, beakers, hot plates, bunsen burners etc. so that you will be able to draw an experiment from start to finish.

Let's say that you are preparing the diagram for an instruction manual in an undergraduate laboratory.  You might want to direct the attention of the students to certain aspects of the set up, possibly even to remind them what the parts are named, or where they are kept in the lab:
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Adding Text Captions

First, let us set the font for the text to be used. From the Tools menu choose Font Panel and Paragraph Panel.  Specify the following settings and close the panel:�		� 		�

�Choose the Text tool � on the left Drawing toolbar and click to the left of the thermometer. In the text box that appears type Thermometer. Sign out from instructor.  To narrow the text box, drag its right border:�					�

If you have accidentally clicked outside the text box but did not finish with the text yet, choose the Edit Text tool � on the upper Editing toolbar. The selected text will be placed into the text box.  If the text has not been selected, simply click on the text with this tool active.

Click outside of the text box to leave the Text mode and to fix the caption.

Repeat steps 2 and 3 to add other captions.

If necessary move the captions to arrange them around the apparatus:
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Inserting Callouts

Now we are going to include the captions into callouts.

On the left Drawing toolbar, click the right-bottom corner (i.e. the small white triangle) of the Callout button � to expand it into more buttons.  From the available styles, choose the square callout type:

�

As you move around with the cursor, you will see the callout shadow appearing around any object you are pointing to.  Point to the text caption so the that callout shadow appears around it and click to fix it:

�

Subsequently point to other captions and click to fix the callouts.  To leave the callout mode, right-click in the workspace.

Reshaping Callouts

Now we are going to modify the callouts so that their pointing ends are directed at the required objects.

Select any of the drawn callouts by clicking on it and choose the Edit Nodes tool � on the upper Editing toolbar.  The nodes appear on the callout:

�

Drag the lowest node to a new location so that the pointing end correctly points to the object you want to say something about:�				�

Dragging the corner nodes modifies the size of the callout.



Without leaving the Edit Nodes mode click on another callout and repeat step 2 as needed.

As soon as all the callouts are re-directed as necessary, right-click in the workspace to leave the Edit Nodes mode.

Using the Draw Arrow tool �, add arrows to indicate the water inlets and outlets.

Select both arrows and double-click to display the Objects Panel. Set the pen color to red and click Apply.

Grouping/Ungrouping Elements

To be able to manipulate this picture as a single object, select all its components by pressing CTRL+A and click the Group button � on the Editing toolbar.  Now you can move and/or�re-size the picture as a whole without the risk to loose or leave behind any of it elements.

If later you decide to edit any of the picture components, select the picture and release the Group button �.

Drawing a Two-chain DNA Strand

(( This section is based on the movie dna_ch.exe which can be downloaded from our Web site or found in the Movies folder.

�

Switch to the � mode and select the Polyline tool �.

Drag vertically down from the starting point of the curve to stretch the control line.

Release the mouse button.

Move the mouse to the right to draw the curve.

Drag vertically down to stretch the control lines.  By changing the length of the control lines you can modify the form of the curve.

Release the mouse button and right-click twice to finish drawing the curve and to switch to the Select/Move/Re-size tool �.�				�

Place the mouse pointer over the selected curve and holding down CTRL+SHIFT keys drag it down (holding down the CTRL key while dragging leaves behind an instant copy of the object and holding down the SHIFT key forces the object to move strictly vertically or horizontally).

Select both curves by dragging the selection rectangle around them or by clicking on each of the curves while holding down the SHIFT key, then choose Connect Lines (in the Object menu) to connect the right ends of the curves.�				�

Choose the Edit Nodes tool � on the Editing toolbar (at the top of the workspace).  Proceed with the following to draw a segment:

Click the Connect Vertices button � to connect the end nodes with a line.

Select the right two nodes by dragging the selection rectangle around them and click the Convert to Line button �.

Right-click to leave the Edit Nodes mode and to switch to the Select/Move/Re-size tool �.

�

Make a copy of the obtained segment by dragging it with CTRL+SHIFT as described in step 6.  Click the Flip Left to Right button � to flip the segment and then click the Send to Back button � to send the segment to the background.�			�

It may take some time to correctly position the segments by manually moving them.  To align their position automatically, select both segments and apply the Center Horizontally � tool to the segments.

Select both segments by dragging or clicking while holding down the SHIFT key and make a copy of them (CTRL+drag).  Correct the position using the directions in the previous step:�				�

�Select the segments marked with bullets in the picture below by clicking on them while holding down the SHIFT key.  Double-click on any of them to open the Objects panel.  In the � tab specify the following settings:

Style - Shade � ;

Color - white;

Pattern - �;

Shade - �

and click Apply:�				�

Select the other two segments (they are marked with crosses in the figure below) and specify the following settings in the Objects panel:

Style - Shade � ;

Color - white;

Pattern - �;

Shade - �

and click Apply to obtain the following spiral:�				�

�Select the whole spiral by dragging the selection rectangle so that it includes all the spiral segments and make a copy of it by dragging+CTRL.  Click the Flip Left to Right � and then Flip Top to Bottom � buttons:�			�

Select the segments marked with bullets in the picture below by clicking+SHIFT and click the Send to Back button �.�				�

Drawing Lipids and Micelles

(( This section is based on the movie lipid.exe which can be downloaded from our Web site or found in the Movies folder.

Drawing the lipid

�

Make sure you are switched to the � mode.

Select the Ellipse tool �.  Drag in the workspace holding down the SHIFT key to draw a circle.  Click with the left mouse button on the black color from the Color Palette (above the status bar) to color the fill of the circle.�				�

Choose the Polyline tool �.  Click repeatedly in the workspace near the circle to draw the carbonic tail and right-click to finish drawing.�				�

To easily draw the symmetric zigzag line, you may previously choose the Snap on Grid and/or Show Grid command (Options menu).

Choose the Edit Nodes tool � and smooth the zigzag line in the following way:

Select all the nodes of the drawn polyline by dragging the selection rectangle around it.  Note that selected nodes become black.

Click on the Convert to Curve button � and then the Smooth button �.

Right-click to switch to the Select/Move/Re-size tool �.�				�

Position the mouse pointer over the curve and drag it holding down the CTRL key to leave the copy of the curve behind.

Arrange the tails as shown by dragging them.�						�

If you select all the elements of the phospholipid and click the Group button �, you will be able to manipulate them as a single object, e.g.  rotate it using the Select/Move/Rotate tool �.

�	Try drawing the micelle picture using the copying feature (CTRL + drag), Group, Rotate 90(, Select/Move/Rotate as well as the aligning and flipping tools :

�

Creating a Poster

Using ChemSketch you can quickly draw a poster and print it on paper of any format.  ACD/ChemSketch will automatically separate the poster into pages; the only thing you have to do (besides design them) is attach them.

(( This section is based on the movie poster.exe which can be downloaded from our Web site or found in the Movies folder.

From the File menu choose the Page Setup command.

In the Size & Orient tab set the paper format and choose the Landscape option.

Select the Poster tab.  Set the number of standard pages you want your poster to consist of by clicking on the spin buttons.  Note that you can see the automatically calculated size of the poster in the Virtual page size field:�	�

In the Margin tabs set the page margins and click OK.

Draw your poster using the tools in the Structure and Draw modes.  Use the Full Page button � to see the general layout as you prepare it.

You can use the Paste and Paste Special commands from the Edit menu to insert objects (text, pictures and etc.) created in other Windows applications.  You can also edit these objects using OLE.

In the Preferences dialog box (Options menu) in the General tab, select the View Printable area check box, if you want to see how your poster will be divided into individual pages while being printed.

Choose the Printer Setup command from the File menu.

In the Select Printer dialog box choose the Set Up button and in the Font tab select the Print TrueType as Graphics option.  Note that this step may be different for each printer.  Click OK.

Choose the Print command from the File menu or click the Print � button on the General toolbar to print your poster and attach the pages.

�Working with Styles in Structure Mode

Objectives

If you often display your structure with a particular set of attributes, such as size of font, type of font, thickness of bond line, etc., you can make ChemSketch remember these settings by saving them altogether as a “Style.”  This is especially helpful if you want to display molecules one way when working with them, but make them conform to a particular journal style when submitting a paper for publication.

In this chapter you will learn how to:

change the style of structures;

save your style;

apply an existing style; and

set a default style.

Changing Style of Structures

A style is collection of attributes for display (atom and bond for structures; pen, arrow, fill, font, paragraph for objects and text) to which you can assign a name and save. 



Using the technique described in Chapter 7 draw the following structure representing the fragment of a DNA molecule.  Save it as dnafrag.sk2.

This structure can be drawn with the help of the Template Window > DNA/RNA Kit tab. Use the 2-deoxyriboso-5-phosphate, uracil and guanine components. When attaching a template, use the SHIFT + click to attach it without creating an additional bond. For more details on how to use the Template Window refer to Section 7.5

��EMBED ACD.ChemSketch.20�����Applying a Journal Style

Let’s say that you have written a scientific article and, to accompany it, you want to submit this drawing of the molecule to the Journal of Organic Chemistry.

Select the molecule using the Select/Move tool �.

Move your cursor over one of the selection markers so that they turn from small outlined squares to solid black squares.  Double-click and the Properties dialog box appears.

Click on the small arrow beside the Style box and a drop-down menu appears.�Select JOC Style (1996) from the list:

�

Click the Apply button and you will see the display of the molecule changes to reflect that journal’s style.  Click beside the molecule to unselect it, so you can see it more clearly:

�EMBED ACD.ChemSketch.20���

From the File menu, select Save As and write your structure to file as dnafrag2.sk2.

Select the whole molecule again, and from the Style menu in the Properties dialog box, select Normal.

Click the Apply button and the molecule should appear as before.

Preparing for Publication

In addition to making your structural drawing conform to the guidelines of a particular journal, there are many other matters to deal with during manuscript preparation.  For this reason, Advanced Chemistry Development has included Instructions for Authors, a hyperlinked list of guidelines for over 40 journals.  Information provided for each journal includes instructions for presentation of tables, figures, manuscript content, etc.

For example, from the Help menu, select Instructions for Authors.

Click American Chemical Society (ACS) Journals and find the Journal of Organic Chemistry in the list.

From the list of items that appears, select Structural Drawings.  The style described is that embodied in the style used in the previous section.

Use the Back button to return to the list of other journals so you can view their guidelines, too.  

Not all journals have explicit instructions for structural drawings, and so they do not appear as a definite style listed in the Structure Properties dialog box.

Creating Your Own Style

Let’s say that you want to make a presentation in which you want to colorfully distinguish between the sugar, phosphate, and amino acid groups of the portion of DNA you are describing.

Open the file dnafrag.sk2 (or draw the DNA fragment shown above in Section 9.2) and confirm that you are in Structure mode.

Switch to the Lasso On tool � and choose the Select/Move tool �.

Select the sugar components by dragging around them (hold down the SHIFT key when selecting separate components):

�EMBED ACD.ChemSketch.20����

�Move the cursor over any part of the selected fragment so that the selection squares become black.  Double-click to display the Properties panel:

�

User-defined Style:  Sugar

In the Atom Style and Bond Style sections click on the color field and set another color for the selected fragments, for example, red.  Set the bond width to a different value, for example, to 1.9 pt.�				�

Units of measurement used in most of the panels within ChemSketch correspond to those set in the Preferences dialog box (Options menu). You may set values for width, length, etc. in points/inches/millimeters/centimeters. Type the values and add the unit you want (pt/in/mm/cm), e.g. 5 pt. The values will be recalculated in the corresponding units of measurement.

Click Apply. As you can see the selected segments are colored with red now:

�EMBED ACD.ChemSketch.20���

To save this style for future use, in the Style list box of the Properties dialog box, type Sugar and click Save:�			�

You will be prompted whether you want to save this user-defined style.   Click Yes.



User-defined Style:  Phosphate

In a similar way, select the phosphate part of the molecule, and define a thick bond width and blue color for the bonds and atom fonts.  

Save this style as Phosphate and then click Apply to carry it out on the molecule:

�EMBED ACD.ChemSketch.20���

User-defined Style:  Base

For the bases, set the color of atom symbols to dark green and for bonds—to neon green.

Save this style as Base and then click Apply to carry it out on the molecule:

�EMBED ACD.ChemSketch.20���

User-defined Style:  Highlight

Perhaps, during the course of your presentation you want to draw the attention of the audience to the oxygen atoms.  We will create a fourth style, Highlight, for this.

Use SHIFT+ click to select the oxygen atoms indicated below with the arrows:

�

Double-click on any of the selected atoms and in the Properties panel, and switch to the Atom tab.

To change the color and size of both atom symbol (oxygen in this case) and hydrogen, SHIFT+click the corresponding buttons in the row below the preview field:�				�

You may also change other atom attributes (hydrogen index, charge, valence, isotope, numbering) by clicking the corresponding buttons.

Change the color, atom size and other attributes, for example, to the following settings:�				�

In a similar manner you may change the bond attributes.

�Click Apply to obtain the following structure:

�EMBED ACD.ChemSketch.20���

Save the style as Highlight.

Applying Existing Styles

To practice applying the styles you have just created, open dnafrag2.sk2.

Use the Lasso tool to select the five-membered sugars as shown in Section 9.3.

Double-click on those sub-structure fragments 

OR choose the Structure Properties command from the Tools menu.

In the Properties panel that appears, from the drop-down list of styles (the field at the top of the panel) choose Sugar:

�

Click Apply. The chosen style will be applied to the selected structure or fragment.

Choose the phosphate groups.  Choose Phosphate from the Style list.  Click Apply.

Similarly, select the two bases in the DNA fragment and choose Apply for the Base style.

The information about a user-defined style is stored on your local hard drive in the Windows or WinNT directory, in a file called USERSTL.SK.  If you want to share your Style file with friends and colleagues, ask them to place a copy of your USERSTL.SK in their Windows (or WinNT) directory.

Setting a Default Style

In the Properties panel from the list of styles choose the required style.

Click Set Default and the selected style becomes the default and any structure drawn from this point on will be of that style.

To set default, you do not have to save your style. You may just specify required attributes in the panel tabs and click Set Default. Your attributes will become default.

�Working with Styles in Draw Mode

Objectives

In Draw Mode, a style may include one or several objects’ attributes: pen, fill, arrow, font and paragraph. This will allow you to create different styles for text, fillable objects, arrows and lines.

In this chapter you will learn how to:

change an object’s style;

save a style; and

set a default style.

Changing the Style of an Object

In Chapter 8, which describes how to draw a DNA chain and orbitals, there was a brief introduction to changing the object’s style. In this section we are going to give you a general procedure.

Select the object (or objects) whose style you want to change.

Double-click on the selection to display the Objects panel. Depending on the type(s) of selected object(s) (shape, linear object, arrow, text, spectrum, table or structure) the Object panel may contain different buttons:

�

Combine your choices from the tabs and the drop-down lists to create your style and click Apply to apply changes.

Settings from the Common section will be applied to all the objects. For example, changing pen color to red will affect shapes, lines and structures. If you change any attribute in the Shapes section only, it will affect shapes only.



Saving a Style



To save the specified settings, click Save As new Style in the Objects panel.

In the Save User Style dialog box that appears, select the attribute that should be included in your style. For example if you want to create a special style for text, make sure that the Font Style and Paragraph Style check boxes are selected.

Type the name for your style and click OK. The style will be added to the list of styles and can be then loaded in into the Objects panel and applied to selected objects or set as default.

Applying an Existing Style

You can apply the saved style (either built-in or user-defined) to any selected object.

Select the object(s) whose style you want to change.

Double-click on the selection to open the Objects panel.

Click Load and from the list of style choose the required one. The style attributes will be loaded into the panel.

Click Apply.

Setting a Default Style

Default settings can be specified in a special style panels available from the Tools menu:

Pen Style Panel

Fill Style Panel

Arrow Style Panel

Font Panel

Paragraph Panel

Settings specified in any of these panels immediately become default.

You may load any existing style into any of these panel by clicking Load. The style is automatically loaded into all the style panels and becomes default.

You may also load style attributes from the drawn object into any of the Style Panels. Click Update From and then on the object. The object’s style attributes are loaded into all the style panels and are automatically set as default.

If you want to change the style of a specific drawn object without effecting default, use the Objects panel (see Section 12.2).

Managing Styles

To manage your styles (save, apply, rename, delete or set as default), you can use the Style Panel that can be opened with the Style Organizer Panel command from the Tools menu:

�

You can do the following in this panel:

To…�Do this…��…view the styles that contain a specific attribute (pen, arrows, fill, font, paragraph).�…make sure that the corresponding button at the top of the panel is pressed-in.��…view the whole list of styles.�…click the buttons at the top of the panel so that they all are pressed-in: �.��…apply the style to the selected object(s).�…highlight the needed style in the list and click Apply.��…set the style as default.�…highlight the needed style in the list and click the Set Default button.��…create new style based on the current default settings.�…click New…��…rename the style.�…highlight the needed style in the list and click the Rename… button.  Note that the built-in styles (they appear in gray in the list) cannot be renamed.��…delete the style.�…highlight the needed style in the list and click the Delete… button.  Note that the built-in styles (they appear in gray in the list) cannot be deleted.��



�Calculating Macroscopic Properties

Overview

ACD/ChemSketch is so versatile in its drawing capabilities that it is possible to overlook the unique macroscopic properties predictions which are built right into it.  These include prediction of 

molecular weight;

percentage composition;

molar refractivity;

molar volume;

parachor;

index of refraction;

surface tension;

density;

dielectric constant;

polarizability; and

monoisotopic, nominal and average mass.

In this chapter, the simple means to calculate these properties is described.  The algorithms for calculating these properties are briefly described.  A summary of the agreement between calculated vs. experimental values is shown for several hundred compounds.

Please note, that in this chapter, “properties” is used to mean physico-chemical values, in contrast to the general use of “properties” in ChemSketch documents, where the characteristics of the graphic display are referred to.  For example, in the Tools menu, the Structure Properties command permits you to set font size, bond thickness, color, etc.  In the same Tools menu, you will also find Calculate > All Properties.

Calculating Macroscopic Properties

Menu Command

To determine any one or all of the following molecular properties, when in Structure mode, draw a structure, select Tools and then choose the Calculate… menu command.  This permits calculation of one or all of the properties mentioned above.

�Once chosen, the calculated property is displayed in a Calculation Result dialog box.  The text content of this can be immediately pasted on the ChemSketch screen if desired by clicking on the Copy to Editor button.  For example, choosing Tools>Calculate…>All properties for benzoic acid will show the following dialog:�		�

Automatic Display on Status Bar

It is also possible to view the macroscopic property directly on the status bar as shown: 

�

Just click on the box to the far right on the status bar and choose the property desired.  By default, this is set to molecular weight.  In the example shown, the dielectric constant, e20, has been specified.

Algorithms for Calculating Macroscopic Properties

At the heart of the additive-constitutive calculation algorithm of all physico-chemical properties in ChemSketch lies the presumption that these properties can be estimated using additive atomic or group increments.  Apart from molecular weight (MW), which is trivial to calculate, the algorithms may be divided into three general groups:

basic macroscopic properties:  Molar Volume (MV), Molar Refractivity (MR) and Parachor (Pr);

derived macroscopic properties: density (d) , refractive index (n) and surface tension (g); and

the dielectric constant e (Permittivity).

Basic macroscopic properties such as Molar Volume (MV), Molar Refractivity (MR) and the Parachor (Pr) are calculated first for the input structure.  The atomic additive increments in such an algorithm depend on the bonds (single, double, aromatic, etc.) of this atom and on neighboring atoms.  ChemSketch rapidly analyzes the input structure to determine the class of each atom, i.e., whether it is cyclic, aromatic, aliphatic, etc.

The prediction algorithms for density (d) , refractive index (n) and surface tension (g) are founded on well known physico-chemical formula which can be found in most physical chemistry textbooks.  These express d, n and g as functions of MV, MR or Pr.  Once the MV, MR or Pr, have been predicted by additive means, it is straightforward to predict d, n and g using these formula.

The determination of the additive-constitutive atomic increments for MV, MR and Pr were obtained internally by ACD using large experimental databases relating structure to density, refractive index and surface tension.  The MV, MR and Pr were recalculated from d, n and g.  These parameters are proprietary information of Advanced Chemistry Development.

The prediction of the dielectric constant e (permittivity) resembles very closely the prediction of Boiling Point, which is a separate ACD product from ChemSketch.  Senior scientists at ACD discovered an additive function, which relates the dielectric constant to other macroscopic  properties which can be additively treated, such as MV.  Once this relationship was discovered, the additive-constitutive atomic increments for this function were obtained using large databases consisting of molecular structures and their observed dielectric constants.  Using the function and estimated MV for the input structure, its dielectric constant can be quickly predicted.

Molar Volume, MV

By definition,

�EMBED Unknown���.

ChemSketch calculates molar volume from additive increments.  The additive atomic increments were obtained using a database of density and calculated MW.

�Molar Refractivity, MR

The Lorentz-Lorenz equation relates refractive index, density, and refractive index:

		�EMBED Unknown���

ChemSketch calculates molar refractivity from additive increments.  The additive atomic increments were obtained using a database of density, refractive index and calculated MW.

Parachor, Pr

By definition,

		�EMBED Unknown���

ChemSketch calculates the parachor from additive increments.  The additive atomic increments were obtained using a database of density, surface tension, and calculated MW.

Density, d

By definition,

		�EMBED Unknown��� 

ChemSketch calculates the density from MW and the calculated molar volume (see above).

Refractive Index, n

By the Lorentz-Lorenz equation,

	�EMBED Unknown���

ChemSketch calculates the refractive index from the molar volume and molar refractivity, both of which are calculated as above.

Surface Tension, g

By definition,

		�EMBED Unknown���

ChemSketch calculates the surface tension from calculated MV (see above) and calculated Pr (see above).

Dielectric Constant, e (Permittivity)

	�EMBED Unknown���

ChemSketch calculates the dielectric constant from calculated MV (see above) and a proprietary empirical additive function.

Polarizability

This property is calculated from the Molar Refractivity (MR) (see Section 11.3.2) as follows:

		�EMBED Unknown���

Monoisotopic, Nominal and Average Mass

Monoisotopic mass (Mmi) is the exact mass of the most abundant stable isotope that can occur naturally.

Nominal Mass (Mn) is the sum of the approximated monoisotopic masses of the elements forming the molecule.

Average Mass (Mav) is the calculated mass of a particle based on the atomic weights of the elements from which it is composed.

Correlation Statistics with Experimental Data

Distribution of Molar Refractivity Prediction Error

			�EMBED Unknown���

Vertical scale:�Number of Tested Structures��Horizontal scale:�ACD Molar Refractivity Estimation Error��Number of tested structures:�592��

MRexp = 0.99901(±0.00067) MRcalc + 0.026(±0.025)	R=0.999867, StD=0.23

Distribution of Molar Volume Prediction Error

			�

Vertical scale:�Number of Tested Structures��Horizontal scale:�ACD/Molar Volume Estimation Error��Number of tested structures:�671��

MVexp = 0.9989(±0.0020) MVcalc + 0.18(±0.29)		R=0.998626, StD=2.74

Distribution of the Parachor Prediction Error

			�EMBED Unknown���

��Vertical scale:�Number of Tested Structures��Horizontal scale:�ACD/Parachor Estimation Error��Number of tested structures:�377��

Prexp = 0.9978(±0.0015) Prcalc + 0.68(±0.46)		R=0.99958, StD=3.11

Distribution of the Refractive Index Prediction Error

			�EMBED Unknown���

Vertical scale:�Number of Tested Structures��Horizontal scale:�ACD/Refractive Index Estimation Error��Number of tested structures:�665��

n20exp = 0.98035(±0.0073) n20calc + 0.028(±0.011)	R=0.982, StD=0.012

Distribution of the Density Prediction Error

�EMBED Unknown���

Vertical scale:�Number of Tested Structures��Horizontal scale:�ACD/Density Estimation Error��Number of tested structures:�671��

d20exp = 0.9947(±0.0036) d20calc + 0.0052(±0.0036)	R=0.995683, StD=0.028

Distribution of the Surface Tension Prediction Error

			�EMBED Unknown���

Vertical scale:�Number of Tested Structures��Horizontal scale:�ACD/Surface Tension Estimation Error��Number of tested structures:�432��

st20exp = 0.998(±0.018) st20calc + 0.08(±0.53) 		R=0.934720, StD=2.84

Distribution of the Dielectric Constant (Permittivity) Estimation Error

�EMBED Unknown���

Vertical scale:�Number of Tested Structures��Horizontal scale:�Dielectric constant (Permittivity) Estimation Error��Number of tested structures:�85  

Note: Derived only for hydrocarbons��eexp = 1.005(0.033)eexp – 0.013(0.072)			R=0.9588, StD=0.079

�Special Function Keys

Objectives

The ChemSketch Window is an extremely versatile molecular structure input editor.  For this reason, several ACD software items are now accessible as single buttons from the ChemSketch interface.  This chapter describes two special add-on modules which can also be accessed from the ChemSketch interface.  ACD/Tautomers is now included with both ACD/ChemSketch commercial and freeware; and ACD/Dictionary is available only with the ACD/ChemSketch commercial software.

Tautomers

The Tautomers button � will automatically check the structure that is drawn alone in the ChemSketch Window or which is selected from several other molecules and will automatically search for Tautomeric forms.

ACD/Tautomers is such a popular request item that we cover it here in some detail.  For more information on Tautomers, as well as many examples of overlooked tautomers in the chemical literature, please refer to the ACD/Tautomers User’s Guide.

Using the above technique draw the following structure:�					�

Select the structure (use the Select/Move tool �), click the Check Tautomeric Forms button � on the Top toolbar.  The program starts generating and checking tautomeric forms of the drawn structure and when the process is finished, the following dialog box is displayed:�	�

To browse through all of the generated structures, click on the � or � buttons.

To replace the drawn structure with the currently displayed structure, click on the Replace button �.

Please refer to the ACD/Tautomers User’s Guide for more information!

Dictionary

ACD/Dictionary is an add-in “Look-up” module, now included with all commercial copies of ACD/ChemSketch.  It is extraordinarily useful at finding “chemicals” by their common names.

ACD/Dictionary finds chemical structures according to their chemical name.  It contains over 48,000 systematic and non-systematic names and their corresponding molecular structures.  The dictionary is searchable by both the full chemical name and  name fragments.

Although the many features of ACD/Dictionary are covered in the ACD/Dictionary User’s Guide, we introduce it briefly here.

On the right References toolbar, click on the Dictionary � button to view the ACD/Dictionary dialog box: 

�

If you purchased ACD/ChemSketch but do not see the ACD/Dictionary button in the ChemSketch Window when you are in Structure mode, please verify that you have correctly entered TWO registration numbers at the time of installation—one for ACD/ChemSketch, and one for the ACD/Dictionary add-in.

Please refer to the ACD/Dictionary User’s Guide for more information!

�Goodies

What are “Goodies”?

What are "goodies"? They are additional tool-buttons that extend the functionality of ChemSketch.  They are, actually, implemented as ACD/ChemBasic programs associated with the 22 new ChemSketch buttons.  ACD/ChemBasic is a special programming language that enables you to customize ACD software, and we think this is a great way to show off how useful it is—and at the same time make your ChemSketch even more versatile!

Note that you do not need to know anything about ACD/ChemBasic (although, if you wish, you can learn it by using the Goodies' code as example).

Where Can I Get Them?

These helpful buttons are already included in most ChemSketch 4.5 installations.  To check if you already have them, look for all *.BAS files within your ChemSketch folder.  If you don’t find any, you can download Goodies from our Web site free of charge at

http://www.acdlabs.com/products/chem_dsn_lab/goodies.html

They are easy to install and to use.  Just follow the installation instructions provided on the Web page and enjoy these new ChemSketch features.

Note that you can remove these new buttons from your ChemSketch toolbar at any time.

ChemBasic Goodies buttons are only available when you are in Structure Mode.

Goodies

Below is the list of Goodies buttons that are available at the moment from our Web site:

Button�Function�How to use��Insert Page

��Inserts blank pages at any place within your ChemSketch document.  Note that the usual way—through a Pages/New menu—adds a page to the end of document.�Go to the page before which you want to insert a blank page and click the Insert Page button.��Clone Page

��Clones current page (together with its contents) a given number of times—it is very useful for filling in the document with page templates, tables, titles, etc.  New pages are added at the end of a document.�Make the page which you wish to clone active.

Click the Clone Page button.

In the dialog box that appears specify the number of clones and click OK.����������Move/ Copy Page

��Moves and copies pages—i.e. changes page order in your document.�Go to the page which you wish to move or copy. 

Click the Move/Copy Page button. 

In the dialog box that appears type in number of the page after which you wish to place the current page and click OK. 

Select Yes in the message box which appears if you want to copy the current page.  Select No if you want to just move it.  Click Cancel to stop program execution.

��Delete Pages

��Deletes a range of pages at a time.�Click the Delete Pages button. 

In the dialog box which appears type the sequence of pages to delete. 

You will be prompted about disabling Undo after program execution.  Choose OK if you wish to delete the pages.  Click Cancel to abort program execution.

��Annotate Document

��Annotates your documents based on the content of the leftmost top textbox on each page.  This is very convenient for managing large documents and presentations.�Open or create a document. 

Click the Annotate Document button. 

After program execution click on the page counter from the bottom status bar to see page names.

��Sketch-to-VRML Converter

��Exports all the molecules in a current page into a VRML 2.0 file, which you may then view with Cosmo, GLView, or any other VRML browser.�Draw structures which you wish to export in one page. 

Click the Sketch-To-VRML Converter button. 

Select OK in the Ready to export...  message box which appears (or Cancel to abort program). 

Type in the file name and path and click OK.  Note that if you have typed in the filename only, the program will place the resulting WRL file in the same directory with sk2vrml.bas. 

Specify the desired structure presentation by typing the corresponding letter in the next dialog box and click OK. 

��SDF-to-Sketch Converter

��Imports the data (molecules, texts, etc.) from a file in MDL's SDF format into ChemSketch document.  Each record in the SDF file becomes a page.  LIMITATION: no more than 100 records may be imported (ChemSketch document may contain 100 pages  maximum).  If the SDF file contains more than 100 records then you will be prompted about partial SDF conversion (and the number of successfully imported records).�Click the SDF-To-Sketch Converter button. 

In the dialog box type in the full path and name (or mask—“*” and “?” are acceptable in the file-mask) of the SDF file which you want to import and click OK.  If you type in the filename without specifying the full path, the program will search your SDF file in ChemBasic program directory.  So, if you place the needed SDF file in the same directory with sdf2sk.bas then simply specify the file name without a path.  If you place the SDF file in ChemBasic’s program sub-directory then iyou need only  type in  the sub-directory name. 

If searching the result contains more than 1 file, the program will suggest you select one, then will ask for the field name.  Specify the field name and click OK.��Document Browser

��Looks through the directories to find specified ChemSketch documents as well as to search ChemSketch documents for the text string without opening them.�Click this button and follow the instructions that appear in the messages.  This is a very useful tool for searching and previewing ChemSketch documents.������Table Wizard

��Creates tables or/and aligns objects according to a specified number of rows and columns�To create a table and place the drawn objects into it:

Click the Table Wizard button. 

You will be informed about the number of objects on the page and some suggestions on how to align them.  Select Yes. 

Specify the number of rows and columns in the table. 

Then choose whether to create borders in the table. 

To create an empty table:

Run the Table Wizard with the blank page active. 

or

Select No in the message box that suggests that you should align objects. 

��Replace Element

��Replaces all the atoms of a given type with atoms of another type in a chemical structure.  This is very useful for drawing, for example, perfluorinated structures.�Note that this program execution is possible only with a single structure on the page.

Draw or leave only one structure on the page and click this button. 

In the dialog box that appears specify the element which you want to be replaced and click OK. 

In the next dialog box specify an element that should replace the one specified before and click OK. 

��Solution Calculator

��Calculates the weight of a compound required for preparing a solution of the user-defined volume and molar concentration.�Note that program execution is possible only with a single structure on the page.

Draw or leave one structure on the page and click this button. 

Specify the required molar concentration and solution volume in the dialog box. 

See the result in the message box that appears. 

��Label Printer

��Quickly creates labels for chemicals and print them on the Avery Standard (45 template sheets included) or your own sheets�Draw structures for which you want to create labels and click this button. 

You can create labels for structures from the SDfile if you run this program with an empty active page. 

For more information see lprinter.txt provided in the Goodies directory. 

��Peptide Builder

��Builds a 3D peptide structure from the amino acids sequence.�Refer to the pepbuild.sk2 file provided in the Goodies directory as a guide to using this button. ��Carbo-hydrate Builder

��Builds a structure from carbohydrate abbreviated names.�For information about how to work with this button refer to the sugarsk.txt file that you can find in the Goodies directory.��Reorder Pages ��Allows you to cut-and-paste or copy-and-paste a sequence of pages to a new position within the same document.�Open the document within which you want to reorder the pages.

Click this button and follow the instructions in the messages.

������Rename Pages 

��Changes the name of pages�Open the document.

Click this button.

Type in the number of a page you want to name and click OK.

Type the name and click OK.

The names of the pages are shown when you click on the “Page 1/1” button at the bottom of your ChemSketch Window.

��Insert Page Numbers/ Annotations

��Inserts page numbers or complex annotations in your document.  Note that annotation will be inserted in a left-bottom corner of the page.�Open or create a document.

Click the Annotate Pages button

Type in a page annotation template in dialog box that appears and click OK.

Annotation template keys:

$P—inserts page numbers

$N—inserts pages names (that can be inserted using Rename Pages goody or using Pages/Rename command) 

You can also include any fixed text into your annotation template.

For example:

Template “$P” will insert page numbers

Template “$N” will place page names in a left-bottom corner of each page 

Template “Page $P” will insert “Page 1”, “Page 2”, etc. annotations

Template: “Page $P: $N” will insert “Page 1: Page Name”, etc. Annotations.

Template that does not contain any keys will insert fixed text for each page—you can, for example, sign all pages with your name.��Create HTML

��Exports all the selected pages of a current document into an HTML file, which you may then view with your favorite web-browser.  Note:  Requires ChemSketch 4.01 or higher.  �All the details may be found in FillTmpHelp.doc file provided in the Goodies directory.��Sketch-To-SDF Converter ��Exports all the structures from the current page or from the whole document into an SDfile.�Open the page with the structures you want to export.

Choose this button and choose what  you want to import—the current page or the whole document.  Click OK.

Specify the name and the path for an SDfile.  Note that if you type in the filename only, the program will place the resulting SDfile in the same directory with expsdf.bas file.��Explicit Hydrogens

��Explicitly shows hydrogens in the drawn structure(s).  �Draw structure(s) on the page and click this button.

Note: you can use standard ChemSketch command—Tools/Remove Explicit Hydrogens—to reverse this goody action.������Remove Spectator Ions (Desalt)

��An SDfile that contains one or more salt structure entries can be changed to a “one-molecule-per-entry” SDfile.  This button removes the smallest ion, either by MW or by number of atoms.  For example, sodium acetate will have the sodium atom removed, and acetic acid will remain behind.  (Note:  the molecule left behind is put into neutral form.)�Specify the name and the path for an SDfile.  Note that if you type in the filename only, the program will look for file in the Goodies directory.

Then define a criterion for smallest part: mass or atom.

The resultant SDfile will be saved in the same directory with the one you have specified under the newfile.sdf name.

A special sample file, “salts.sdf” with 5 salts in it is placed in the Goodies directory for testing.

Hint:  use the “Import SDF” Goody to double-check Newfile.sdf.

��Nucleic Acid Builder ��Builds a 3D nucleic acid (DNA, RNA) structure (one or two chains) from your input sequence.  �Click this button and follow the instructions from the messages.��



�Conclusion

Thank you for choosing ACD/ChemSketch.  We have endeavored to produce the easiest to use, most powerful chemical drawing program available today.  As of Fall 2000, over 70,000 copies of ACD/ChemSketch are in circulation, and we think there is a reason for its growing popularity!

Completion of Chapter 3 of this guide should have given you the tools needed to get started working with the program.  Completion of Chapter 4 of this guide should have made you comfortable with a new dimension to ACD/ChemSketch, the I-Lab.  Completion of the remaining chapters of this ChemSketch guide has made you a highly proficient ChemSketch user, and we welcome you to the “club” of ChemSketch gurus. 

This overview, combined with the online Help, should be enough to allow you to accomplish many things with this powerful yet intuitive package.  On the rare occasion that further assistance is required, or if you have feedback on this manual or any aspect of the software, we would be happy to hear from you.  We can be contacted via the avenues described in Chapter 1.8.



And furthermore…

�EMBED PBrush���

Win!!!

Tell us how we can improve this Guide.�Once you have used this Guide, we would like your feedback.  How can we improve the documentation for this product?  We have a short questionnaire we would like you to complete.  All eligible respondents will be entered in a draw for a prize of ACD/ChemFolder (or equivalent discount toward the purchase of any ACD software).  Please use MS Word 6.0 or higher to open the file “survey.doc” or use Adobe Acrobat Reader to open “survey.pdf” on the documentation CD you have received with this software, or visit the “Feedback” page at our Web site, http://www.acdlabs.com/feedback/guides.html.  The winner of the draw will be announced at the end of the calendar year.��

� The details for the SK2 file format are spelled out in the SK2 Format document available from http://www.acdlabs.com/download/#misc.

�  B. R. Brooks, R. E. Bruccoleri, B. D. Olafson, D. J. States, S. Swaminathan, and M. Karplus. CHARMM: A program for macromolecular energy, minimization, and dynamics calculations. J. Comput. Chem. 4 187-217 (1983).

� Check first in the “Template” folder of the ACD/ChemSketch freeware for the desired template.  If you don’t find it there, go to http://www.acdlabs.com/download/download_templates.html.



Table of Contents



ACD/ChemSketch 	User’s Guide	�PAGE  �91�



ACD/ChemSketch 	User’s Guide	�PAGE  �i�



� REF _Ref452371692 \* MERGEFORMAT �Introduction�







ACD/ChemSketch	User's Guide	� PAGE �90�



� REF _Ref452371773 \* MERGEFORMAT �Basics of ACD/ChemSketch�



� REF _Ref452371814 \* MERGEFORMAT �Drawing Simple Structures�



� REF _Ref496947871 \* MERGEFORMAT �Getting Started with ACD/I-Lab�



� REF _Ref452371889 \* MERGEFORMAT �Drawing More Complex Structures�



� REF _Ref497045157 \* MERGEFORMAT �Advanced Structures and Reaction Schemes�



� REF _Ref452371987 \* MERGEFORMAT �Advanced Drawing: Templates�



� REF _Ref452372036 \* MERGEFORMAT �Creating Graphical Objects�



� REF _Ref489334264 \* MERGEFORMAT �Working with Styles in Structure Mode�



� REF _Ref489334282 \* MERGEFORMAT �Working with Styles in Draw Mode�



� REF _Ref496515969 \* MERGEFORMAT �Calculating Macroscopic Properties�



� REF _Ref452372136 \* MERGEFORMAT �Special Function Keys�







� REF _Ref456003784 \* MERGEFORMAT �Goodies�








